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SOFTWARE LICENSE AGREEMENT 
Carefully read all the terms and conditions of this Agreement prior to installing software.  Do not 
activate this software until you have read this entire Agreement.  Installing this software indicates 
your acceptance of these terms and conditions. 

If you do not agree to these terms and conditions, then return the software and other components 
of the software package of this product to the place of purchase and your money will be refunded.  
If you downloaded this software in its demonstration form and you do not agree to the terms of the 
license, you may retain the software only in its demonstration form solely for the purpose of 
passing on the demonstration software to another prospective buyer.  No refunds will be given for 
products downloaded off of the Internet that have been registered and activated. 

1. LICENSE: You are granted a personal, nontransferable, and nonexclusive, license to use the 
enclosed software, under the terms stated in this Agreement.  Title, copyright and ownership of the 
software and any and all related documentation remains with Rockton Software, Inc. (Rockton 
Software).  This software and related programs may be used only on a single site licensed for use 
of Microsoft Dynamics GP, for the number of concurrent users as provided for in the original 
Microsoft Dynamics GP registration and purchase.  Registration keys can be obtained directly from 
Rockton Software, if applicable.  You may not distribute copies of the registered and activated 
software or any of the associated documentation to others.  The demonstration version of the 
software may be distributed freely.  You may not modify, reverse engineer, de-compile, 
disassemble or translate the software or related documentation without the prior written consent of 
Rockton Software. 

2. BACKUP: You may make backup copies of this software solely for your own use.  You must 
reproduce and include the copyright notice on the backup copies.  If all or any portion of this 
software is included in other software packages, then the copyright notice must appear on these 
other materials. 

3. TRANSFER: You may not transfer this software to any other party.  There are no provisions 
whatsoever for any other transfer, operation, or use of the software by any other party whatsoever 
except for the original buyer of the product, which has been registered with the Rockton Software at 
the time of original purchase and software activation. 

4. LIMITED WARRANTY: Rockton Software warrants for a period of thirty days (30 days) from the 
date of receipt that the software covered by this agreement will perform substantially in accordance 
with the accompanying written documentation.  You assume the entire risk as to the results and 
performance of the software.  This warranty gives you specific legal rights and you may also have 
other rights that vary from state to state.  Rockton Software makes no claim in regard to the 
merchantability or suitability for any specific purpose of this or any other software product. 

5. ACKNOWLEDGMENT: By activating and using this product you acknowledge that you have read 
this agreement, understand it, and agree to be bound by its terms and conditions.  You also agree 
that this agreement is the complete and exclusive statement of agreement between the parties and 
supersedes all proposals or prior agreements, verbal or written, and any other communications 
between the parties relating to the subject matter of this agreement. 

6. REMEDIES: Rockton Software's entire liability and your exclusive remedy shall be at the option of 
Rockton Software, either (a) return of price paid or (b) repair or replacement of the software that 
does not meet the limited warranty and is returned to Rockton Software.  If you have need of 
service or help regarding this software, you should contact the dealer through which the software 
was originally purchased.  There is no obligation to render assistance to you if you are not the 
owner under which the software is registered, or if the registered user has not purchased a 
recognized support plan from the vendor of this product.  The laws of the State of Colorado will 
govern this Agreement. 
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Introduction 
 

Dynamics GP Toolbox is jam-packed with the Tools our customers have asked for! 
The GP Toolbox foundation was built by combining three of our popular products, 
Omni Tools, Mentor, and Conditional Field Level Security, to arm our customers with 
even more ways to simplify their day-to-day operations in Microsoft Dynamics GP. 
GP Toolbox includes tools to improve navigation, security, and tighter integration to 
make Security, Administrative tasks and the User Experience of Dynamics GP 
Simple and Easy. It doesn’t matter if you are a System Admin or an End User, 
Dynamics GP Toolbox has something for everyone! 
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What’s in This Manual 
 
 
This manual contains the basic instructions needed for the installation and use of 
Rockton Software’s Dynamics GP Toolbox.  You will find instructions for: 
 

• Installation 

• Navigation 

• Setting up Dynamics GP Toolbox 
 
If you do not find the information you need in the following documentation, please 
contact Rockton Software (see the following page).  
 
 
Symbols and Conventions 
 
To help you use this documentation more effectively, we have included the following 
symbols to highlight important information: 
 
 

 
This symbol points out suggestions and important notes 
that assist you in installing and using Dynamics GP 
Toolbox. 
 

 
The warning symbol alerts you to situations in which you 
should proceed with caution.  Notes highlighted with a 
warning symbol relate to information that affects your entire 
system—please read carefully!  

 
• Keyboard keys, specific buttons, file names and menu 

paths are shown in bold print, such as the Move Right 
button, the OK key or the setup.exe program.  

 

• Window titles and captions are shown in quotes, such as 
the “Maintenance” window. 

 



Rockton Software Dynamics GP Toolbox, 3/19/2024  9 

Customer Technical Support 
 

Technical support from Rockton Software is simple. With an active maintenance 
agreement, support is unlimited and available to Resellers and Customers alike. We 
can communicate via telephone, fax, email, web conference, or other means if 
possible. Beyond FAQs and product manuals available on our website, we prefer for 
all customers to utilize their Reseller for support, as it is usually most efficient and the 
customer’s Reseller is more familiar with all third party products on site and the 
specifics of the customer’s needs. However, we will also provide direct support as 
requested. Without an active maintenance agreement, no technical support is 
offered. 

As always, user input into improving this product, constructive feedback or technical 
ideas are always appreciated and highly encouraged.  At Rockton, we want to hear 
your input. So drop us a line whenever you feel like it.  

You can reach us by contacting technical support from Rockton Software by phone 
at (877) 476-2586 or e-mail support@rocktonsoftware.com. You can also visit 
www.rocktonsoftware.com for more information on Rockton products, including a 
Frequently Asked Questions section. 

Enjoy! 

mailto:support@rocktonsoftware.com
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System Requirements 
 
The system requirements for installing and using Dynamics GP Toolbox follow those 
of Microsoft Dynamics GP.  The following table lists the specific hardware and 
software requirements that pertain to Dynamics GP Toolbox: 

 

Server Operating System One of the following: 

X64 

• Microsoft Windows Server 2019 Essentials, Standard, or 
Datacenter Edition 

• Microsoft Windows Server 2016 Essentials, Standard, or 
Datacenter Edition 

• Microsoft Windows Server 2012 Essentials, Standard, or 
Datacenter Edition 

• Microsoft Windows Server 2012 R2 Essentials, Standard, or 
Datacenter Edition 

Client Operating System One of the following: 

• Microsoft Windows 10 Professional or Enterprise Editions 

• Microsoft Windows 8 or 8.1 Professional, Ultimate, or Enterprise 
Editions 

• Microsoft Windows 7 Professional, Ultimate, or Enterprise 
Editions 

Available hard disk space 5 MB in the Dynamics GP install folder; 5 MB in the DYNAMICS database 

Minimum available RAM 2 GB (more recommended) 

Microsoft SQL Server  One of the following: 

• SQL Server 2019 Enterprise, Standard or Express Editions 

• SQL Server 2016 Enterprise, Standard or Express Editions 

• SQL Server 2014 Enterprise, Standard or Express Editions 

Microsoft Dynamics GP One of the following: 

• Version 2018.2 

Adobe Acrobat Reader Adobe XI, X, 9.0, 8.0, 7.0, or 6.0 
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Upgrading Old Rockton Products 

Dynamics GP Toolbox replaces Omni Tools, Mentor, Conditional Field Level Security 
and Version Pro. If you have any of these products installed, the installation process will 
be comprised of three steps: 

1. Upgrade old Rockton products to the current build 
2. Save settings and uninstall old Rockton products 
3. Install Dynamics GP Toolbox 

For the first step, you will need to make sure that you are on the current build of each of 
the old Rockton products being replaced.  You can obtain these builds from our website 
(http://www.rocktonsoftware.com/products.aspx?p=12) from the same page where you 
downloaded Dynamics GP Toolbox.  This is important if you wish to bring forward the 
settings that you had configured in these products into Dynamics GP Toolbox. 

The second step will save any settings from the old Rockton products that pertain to 
Dynamics GP Toolbox, and then uninstall these products.  You will then be automatically 
logged out of Dynamics GP.   

When you log back in, the installation process will automatically start to install Dynamics 
GP Toolbox for the third and final step.  Your saved settings from the second step will be 
loaded at this time. 

Upgrade Old Rockton Products 

1. First, download the latest builds of any of the products mentioned above that you 
currently have installed on your system.   

 You only need to upgrade Version Pro if you are using the stand-alone Version 

Pro product.  Starting with Omni Tools build 10.0.6, Version Pro was included 

with Omni Tools.  Therefore, if you have build 10.0.6 or later of Omni Tools 

installed, then you should ONLY upgrade Omni Tools, not Version Pro as well. 

2. Copy one of the chunk files for the products that you are upgrading to your local 
Dynamics GP installation folder.  Do not copy the Toolbox chunk file yet. 

 We recommend that you upgrade one product at a time, rather than copying in 

and including all of the chunk files that you downloaded in step 1. 

3. Include the new chunk file code into Dynamics GP by launching Dynamics GP.   

The following message may appear: “New code must be included in the DYNAMICS.SET 
dictionary.  Do you wish to include new code now?” Click Yes. 

4. Log in as the ‘sa’ User. 

5. Log into any company.  Each of the products you are replacing maintains data at the 
system level.  Therefore you can perform the upgrade from any company.  

6. After logging in, you will see a message indicating that you need to upgrade the product 
that you have just included.  In addition the corresponding Setup window for that product 
should open.  With the Install/Upgrade option selected in the Task drop-down, Click the 
Process button on the Setup window.  Dynamics GP should shut down when this process 
completes.  If it does not, then we recommend that you manually shut down Dynamics 
GP after the installation process completes. 

Repeat steps 2-6 for each product that you need to upgrade.  Once all products have been 
upgraded, continue with the instructions on the next page. 

http://www.rocktonsoftware.com/products.aspx?p=12
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Save Settings and Uninstall Old Rockton Products 

1. Run the Dynamics GP Toolbox setup file (ToolboxSetup.exe).  Verify that the directory on 
this window matches your local Dynamics GP installation folder, then click Install.  If the 
Status shows “Installed Successfully.” for each item listed, click the Exit button on the 
setup window to close the setup program. 

2. Include the new chunk file code into Dynamics GP by launching Dynamics GP.   

The following message will appear: “New code must be included in the DYNAMICS.SET 
dictionary.  Do you wish to include new code now?” Click Yes.   

This process will modify your DYNAMICS.SET file to include information relating to 
Dynamics GP Toolbox, and the Toolbox.cnk file will create a TOOLBOX.DIC file. 

3. Log in as any User that has sufficient SQL Server rights to be able to create Tables.  This 
user must either be in the ‘sysadmin’ fixed server role or the ‘db_owner’ role for the 
DYNAMICS database.  

4. Log into any company.  Each of the products you are replacing maintains data at the 
system level.  Therefore you can save settings and uninstall from any company.  

5. If you already have Omni Tools or Version Pro installed and Version Pro is enabled, you 
may receive a message indicating that Version Pro has found conflicts that need to be 
resolved.  Ignore these messages for now. 

6. Once the login process has completed, you will see a message saying that older Rockton 
products need to have their settings saved and then be uninstalled. Click OK. 

7. Next, you may see a dialog that tells you that all windows from any older Rockton 
products need to be closed before you can continue with the upgrade.  If you are ready to 
upgrade now, click the Continue button and any Omni Tools, Mentor, Conditional Field 
Level Security or Version Pro windows that are open should close automatically.  
Otherwise click Cancel and the upgrade process will be stopped. 

8. The Save Settings window should open.  Review the information on this window and click 
the Next button to save the settings you have entered for the products listed. 

 

 

9. You may see the Security Changes Report displayed at this time.  This report contains 
information about manual changes to your Security setup that you or your Security 
Administrator will need to make in order to duplicate what was set up in the Control Panel 
in Omni Tools.  This report can also be found in the Dynamics GP Data folder under the 
name RSTB_SecurityChangesReport.txt. 
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10. The description area at the top of the Save Settings window will now say “Review Saved 
Settings”.  If there were any problems encountered in saving your settings, then you will 
see an alter message telling you this.  Click OK on this message and proceed to step 11.  
Otherwise, if there were no errors, continue to step 10. 

11. This window indicates which tables have data that will be migrated into Dynamics GP 
Toolbox.  This information is also saved to a text file called 
RSTB_GPToolboxConversionReport.txt, located in the Data subfolder of the Dynamics 
GP install folder.  Click Finish to uninstall the products listed at the top of this window.  
Then proceed to step 12. 

 

 

12. The specific errors found will be listed at the bottom of the window.  In the example 
below, you are informed that you have not upgraded to the latest build of Omni Tools.   
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If you choose to ignore these errors and click Finish anyway, the older Rockton products 
will be uninstalled and the install of Dynamics GP Toolbox will continue.  However, some 
or all of your settings will not be migrated  into Dynamics GP Toolbox!  There may 
be cases where this is perfectly OK.  For instance, you may have installed one of the 
other products but never actually configured it.  In this case, you may want to just start 
over and configure settings from scratch in Dynamics GP Toolbox. 

If you want to save your settings however, click Cancel and resolve the errors first.  
Dynamics GP Toolbox will be uninstalled from the launch file and Dynamics GP will shut 
down. To continue the installation process, you will need to start again from step 1 of the 
Save Settings and Uninstall Old Rockton Products section. 

13. You will now see a message telling you, “Save settings and uninstall steps complete.”  
When you click OK on this message, Dynamics GP will shut down.  Your settings have 
been saved (if appropriate) and any old Rockton products that Dynamics GP Toolbox 
replaces have been uninstalled. 

 

Install Dynamics GP Toolbox 

To complete the third and final step, follow the First Workstation Instructions in the following 
Installation section.  
 
You will also need to complete the Workstation Installation Instructions for all other 
workstations where you want have Dynamics GP Toolbox installed.  Be sure to do this on all 
workstations that have Omni Tools, Mentor, Conditional Field Level Security or Version Pro 
installed, otherwise you will need to uninstall these products from those workstations manually. 
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Installation  

  

Please read these instructions in their entirety before installing this software. 

Workstation Installation Instructions 

1. Extract all of the files and folders in the zip file you downloaded to a folder where you 
can access it from all workstations that you are going to install. 

2. From each computer on which you wish to install Dynamics GP Toolbox, right-click the 
Dynamics GP Toolbox setup file (ToolboxSetup.exe) and choose Run as administrator.   

 It is recommended that you are not running any other Windows programs when 

installing this program 

3. Select the folder where Dynamics GP is installed.   

 Important!  Install Dynamics GP Toolbox to the same directory where Dynamics 

GP is installed.  If the default directory on the Dynamics GP Toolbox Installation 

Wizard window is not the same as the Dynamics GP installation directory, 

modify the default directory.   

If you enter this incorrectly, Dynamics GP Toolbox will not function! 

 

4. Click the Install button.  This will copy Toolbox.cnk and any other files as appropriate.  It 
will also install any other components that are necessary to run Dynamics GP Toolbox.  
On some installations, you may have to reboot your system.   

5. Verify that the Status shows “Installed Successfully.” for each item listed.  Then click the 
Exit button on the setup window. 

6. Include the new chunk file code into Dynamics GP by launching Dynamics GP. Be sure 
to right-click the Dynamics GP icon, choose More, then choose Run as administrator. 

The following message may appear: “New code must be included in the DYNAMICS.SET 
dictionary.  Do you wish to include new code now?” Click Yes.   

This process will modify your DYNAMICS.SET file to include information relating to 
Dynamics GP Toolbox, and the Toolbox.cnk file will create a TOOLBOX.DIC file. 

7. You will be prompted to exit GP. Log out of GP and log back in. 

You should now exit Dynamics GP to complete the installation process for each 
workstation. If this is the first workstation in your network on which you are installing 
Dynamics GP Toolbox, continue with the following section.  

First Workstation Instructions 

If this is the first workstation on which you are installing, complete the following steps.   

 You will need to complete these steps only once for your system.  You do not need 

to perform these steps in each company.   

 
1. First, complete steps 1 thru 6 from the previous section. 

2. Log in as any User that has sufficient SQL Server rights to be able to create Tables.  This 
user must either be in the ‘sysadmin’ fixed server role or the ‘db_owner’ role for the 
DYNAMICS database.  
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3. Log into any company. Since Dynamics GP Toolbox maintains data at the system level, it 
is only necessary to install the software in one company. If you don’t have a registration 
key, we recommend that you log into the Dynamics GP lesson company.   

 If you are evaluating the software and have not yet received a product registration 

file, this product will only work in the Dynamics GP lesson company.  To register, 

contact Rockton Software or your authorized reseller. 

4. Next, the Dynamics GP Toolbox Install Welcome window will open.  Note the status 
message.  This indicates whether you will be installing from scratch or upgrading from an 
earlier build.  

 

5. Click the Next button to review the License Agreement. 

 

6. Mark the Accept License Agreement check box, then click the Next button to launch the 
Install Progress dialog.  You may see some informational messages as the installation 
continues.  Take note of these and click OK or respond to them as necessary.    



Rockton Software Dynamics GP Toolbox, 3/19/2024  17 

 

7. If you have Security Auditor installed and have created Filters, you will be allowed to 
Import Filters from Security Auditor into Dynamics GP Toolbox at the end of the install.   

 Security Auditor must be on at least version 10.0 to import Filters.  If you are on 

an earlier version of that product, you must first upgrade before using the import. 

8. When the installation has completed, press the Finish button.  The Dynamics GP Toolbox 
Install Status and Dynamics GP Toolbox Setup windows will open.  Take note of any 
messages on the Install Status window and click OK. 

9. If you have not previously registered your software, the following window will open: 

 

This will show any Rockton products not currently registered. If you wish, you can click 
the Register button to have your registration loaded automatically. 

To register the product manually, choose Registration on the Dynamics GP Toolbox 
Setup window to open the Dynamics GP Toolbox Registration window. Click Import 
Registration and import the registration file you received previously.  

For subscription products that are registered, a periodic check is done to verify their 
registrations are valid. Administrators may see a progress dialog when logging in during 
this check while non-admin. users will not. We recommend an administrator log in 
periodically to verify your subscription status for each product. If issues are found during 
the process, you will see a message relating to the issue. 
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10. Log out of Dynamics GP and log back in. 

Verify the Installation 

Test at least the Inactivity Timeout tool (if you are using it) using different user types 
(POWERUSER, Dynamics GP Toolbox Administrator, regular user, etc., as 
appropriate) in a company other than Fabrikam. 
 

This completes the installation process for the first workstation.  

Removing Dynamics GP Toolbox 

These steps will completely remove Dynamics GP Toolbox from workstation and server: 

1. Log in to Dynamics GP as any User that is either in the ‘sysadmin’ fixed server role or the 
‘db_owner’ role for the DYNAMICS database. 

2. Open the Dynamics GP Toolbox Setup window and select the Uninstall Tab.  Then select the 
Complete Uninstall task to completely uninstall from the server, or select Workstation 
Uninstall to simply remove it from the current workstation. 

3. Click OK on the message to close Dynamics GP. 
4. Delete the following files from the Dynamics GP install folder (you may not find all of them): 

TOOLBOX.DIC TOOLBOX.VBA Toolbox.cnk 
Dynamics GP Toolbox Manual.pdf Dynamics GP Toolbox ReadMe.txt Toolbox.chm 

 Any files that start with RSTB_BACKUP_Toolbox and have an extension of .xml or .xmlSAVE 

5. Delete the following files from the Dynamics GP Data folder (you may not find all of them): 
FRMS6443.DIC RPTS6443.DIC 

6. If you chose Complete Uninstall in step 2, then log on to Dynamics GP as a User that has 
access to the Security windows.  Remove the GP TOOLBOX ADMIN Security Role and the 
ADMIN_GP_TOOLBOX_01 Security Task. 

Manually uninstalling 

The following steps can also be used to manually remove Dynamics GP Toolbox: 

Manually uninstalling from a Workstation 

Perform this process on each workstation where you want to remove Dynamics GP Toolbox. 

1. Edit the Dynamics.set file (located in the Dynamics GP installation directory) to remove the 
Dynamics GP Toolbox entries.  There are three steps to this: 

a. The first line in the file should be a number.  Subtract 1 from this number. 
b. Remove these two lines: 

6443 
Dynamics GP Toolbox 

c. The bottom part of the file contains several path names.  Remove the ones that 
reference the following dictionaries: TOOLBOX.DIC, FRMS6443.DIC and RPTS6443.DIC. 

2. Delete the following files from the Dynamics GP install folder (you may not find all of them): 
TOOLBOX.DIC TOOLBOX.VBA Toolbox.cnk 
Dynamics GP Toolbox 
Manual.pdf 

Dynamics GP Toolbox 
ReadMe.txt 

Toolbox.chm 

 Any files that start with RSTB_BACKUP_Toolbox and have an extension of .xml or .xmlSAVE 

3. Delete the following files from the Dynamics GP Data folder (you may not find all of them): 
FRMS6443.DIC RPTS6443.DIC 

Manually uninstalling from the Server 

Perform this process to completely remove Dynamics GP Toolbox from the system. 
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1. Open SQL Enterprise Manager. 
2. Drop all tables in the DYNAMICS database that are named RSTBxx, (xx is the table number). 
3. Drop all stored procedures in the DYNAMICS database whose names start with 

zDP_RSTBxxYYY (where xx is the table number and YYY is one of 11 possible suffixes). 
4. Perform step 6, above, to remove Security Tasks and Roles. 
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Navigation  

A Dynamics GP Toolbox menu is added to the Setup, Routines and Inquiry menus in 
Dynamics GP.  You will be able to access most of Dynamics GP Toolbox’s functionality 
from these menus. 

However, you may find it more convenient to use the Dynamics GP Toolbox Toolbar for 
day-to-day usage.  The toolbar includes these three buttons:  

•    Dynamics GP Toolbox Setup menu 

•   Mentor 

•   Payment Approval 

 

Limited Users in Dynamics GP will typically only be able to use Inquiry and Reporting 

functionality.  There may also be cases where other types of windows may also be 

available to a Limited User because they are necessary to perform the basic functionality 

of this product.  

Adding a Limited User to this product’s ADMIN security role may result in some 

Administrator functions becoming visible for that user.  Accessing these functions will 

typically result in a message indicating that the user does not have security privileges to 

the window that performs that function. 

Backup and Restore 
All Dynamics GP Toolbox data is stored in the DYNAMICS database.  Therefore, performing the 
process normally used to backup this database should also backup all Dynamics GP Toolbox 
data.  Similarly, restoring this database will restore Dynamics GP Toolbox data as well. 

Dynamics GP Toolbox Security Settings 

Security in Dynamics GP Toolbox can be administered via the following Security Items: 

• GP TOOLBOX ADMIN Security Role 

Used to set access to an Administrator of Dynamics GP Toolbox 

• ADMIN_GP_TOOLBOX_01 Security Task 

Contains all windows necessary to setup and administer Dynamics GP Toolbox.  Typical 

Users do not need to have access to these windows. 

• DEFAULTUSER Security Task 

Contains all the windows that are required for the average User to be able to use Dynamics 

GP Toolbox.  No setup or administration windows are included. 
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Customization 

Dynamics GP Toolbox has been built using Microsoft Dexterity.  Therefore, you can use 
the tools typically available to a Dexterity developer (Modifier, Report Writer, etc.) to 
customize and extend it.  Refer to the Microsoft documentation on these tools for more 
information. 

System Administrators 

Certain users of this software will have the ability to perform functions that the average 
user cannot.  These functions may include but are not limited to installation, setup, and 
configuration of advanced features.  We will refer to these users as “System 
Administrators”.  This may also be abbreviated to Administrators, or just Admins. 

In Dynamics GP Toolbox an Administrator is defined as any user that is in either the GP 
TOOLBOX ADMIN or POWERUSER Security Role. 
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About Dynamics GP Toolbox window 
 
 

 
 
You can access this window as follows: 

• Go to Help >> About Microsoft Dynamics GP and choose Additional >> About Dynamics 
GP Toolbox.  

 

Description 
 

The About Dynamics GP Toolbox window shows the version of Dynamics GP Toolbox 
that you have loaded, along with the phone number to use to contact Rockton Software, 
and a link to our website.  In addition, it also provides a convenient means of navigating 
to the Dynamics GP Toolbox Registration window. 
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Rockton Software Registration Issues window 

 

This window opens automatically if any Rockton products are not properly registered: 

• when you exit the Dynamics GP Registration window. 

• when a System Administrator logs in. 

• after completing the Installation Wizard. 

Description 

Whenever you close the Dynamics GP Registration window, the registration for all 
Rockton products that you have installed will be verified. If any are found to be invalid 
(for instance, because the User Count or Site Name has changed since the last time the 
Rockton registrations were updated), then this window will open automatically. The box 
at the bottom of the window will list each Rockton product that requires new registration. 
 
You can attempt a new registration for the products listed. If you do not have a valid 
registration for any of the products listed, in most cases you will be given a temporary 
registration that will expire in 30 days.  
 
To retrieve your registration information, simply mark the check box for each product that 
requires new registration, and then click the Register button. This will automatically 
attempt to register each product selected. If registration cannot be obtained, you will see 
a message that indicates there was a problem. You can click the text in the Message 
column to see additional information on resolving the issue. After a request has been 
sent to register, an icon appears to the left of the Product Name that will show the results 
for the registration attempt. You can click the icon to get more information related to the 
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results of the request. 
 
You may also import the product registration file that may have been provided to you 
from the Rockton Sales team by double-clicking the product in the list above or clicking 
the Edit icon. This will open the Registration window for that product. From there, click 
the Import Registration button and import the file. 
 
If you are using a subscription product, a subscription check is run periodically to 
validate the current registration. Administrator users will see a progress dialog when this 
request is made and will see messages if there is an issue with the registration. Non-
administrator users will not see this progress so we recommend an administrator log in 
to Dynamics GP periodically to validate registrations for Rockton products. If information 
has changed regarding Site Name, User count, or Dynamics GP version, the registration 
will become invalid and you will need to contact Rockton Software for further assistance. 
If you're using a non-subscription product, your registration will continue to be verified 
and open the Rockton Software Registration Issue window when an issue is found. 
 
If you plan to resolve the registration issue at another time, you can click Ask Me Later to 
be prompted with this window later. The options are Next Login or Tomorrow. 
 
You can click the More Info button for steps on how to register the product. 
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Enter Contact Information window 
 

 
 

Description 

This window opens automatically when a request is made for registration and your Site 
Name does not exist in our system. You can enter the information and click Save or you 
can contact Rockton Software directly to register your product. 
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Dynamics GP Toolbox Registration window  
 

 

You can get to this window in one of these ways: 

• From the Navigation Pane. 

• Go to Help >> About Microsoft Dynamics GP… and from the Additional menu, choose 
About Dynamics GP Toolbox.  Then click the Register button. 

• Log on as a User in the GP TOOLBOX ADMIN Security Role or the POWERUSER 
Security Role and go to Microsoft Dynamics GP > Tools > Setup > Dynamics GP Toolbox 
> Dynamics GP Toolbox Setup. Then click the Registration task. 

• From the Rockton Software Registration Issues window, double-click a product in the list. 

• Clicking the Help icon ( ) and then choosing Rockton Software Support from the drop-
list. Click the Register button.  

• Click the Administration navigation button to open the Administration Area Page.  Then 
select Dynamics GP Toolbox Setup from the Dynamics GP Toolbox sub menu.  From the 
drop-down, choose Registration and choose the Process button. 

Description 

The Dynamics GP Toolbox Registration window is where you can automatically register 
your product or manually import the product registration file.  
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You can tell from the Status field whether the product is registered or if there is an issue 
with the registration. 

 

Status Values 

No registration exists Registration request has not been made due to new product install 
or product has been unregistered. 

Product is registered Product was registered successfully. 

Registration is expired Existing registration has expired. For example, a trial registration 
expires after 30 days. 

Registration is invalid Registration information does not match information in Dynamics 
GP. Typically, this is due to Site Name, User Count, or Dynamics 
GP version not matching. 

 
To automatically register the product, click the Register button and a request will be 
made to check for valid a registration. If found, the window is populated with the 
necessary information and the Status is set to Product is Registered. If a valid 
registration is not found, then you will receive more information as to the status of the 
registration. 
 
If you need to manually import the product registration, click the Import Registration 
button. Select the XML file you received previously from Rockton Sales. If the file is 
valid, the Status field will show Product is Registered. If the file is not valid, the Status 
will show Registration is invalid or Registration is expired.  
 
If the Site Name, Microsoft Dynamics GP Version, or user Count does not match the 

current Dynamics GP values, a warning indicator ( ) will appear next to the 
corresponding field. If the registration has expired, you will see a warning indicator next 
to the Expiration Date field. 
 
The Registration Messages box will provide additional information regarding the 
registration information that was obtained from the request or from the import. 
 
Should you need to Unregister the product for any reason, click the Options button and 
then click Unregister product. This will automatically remove the registration information 
from the window.  
 
If you hare having issues with registering the product, contact Rockton Software to verify 
that your Site Name, User Count and Dynamics GP version have not changed since 
your last registration.  
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Newer Rockton Software Builds are Available window 

 

This window opens automatically when a System Administrator logs in if any Rockton products 
are found to have newer builds available for download on www.rocktonsoftware.com. 

Description 

Whenever an Administrator logs in, the system will check to see if any of the installed 
Rockton products have updates available on the Rockton Software website.  If all 
products are up-to-date, then this window will not open.  Otherwise, the products that 
have updates available will be listed here.   

You will see the build that you currently have installed, as well as the Latest Build 
available on our website.  If you select any of the products listed, you will see the 
changes for that build in the box at the bottom of the window. 

If you want to download any of the latest builds, click the Get Builds button and your 
Internet browser will open to the Downloads page on our website.  Here you will see all 
of the latest builds for each of our products and each version of Dynamics GP for which 
they are available.  If you don’t want to download at this time, click the Cancel button. 

If you don’t want to be notified of new builds any more, mark the “Don’t show me this 
again” check box and you won’t be notified of a new build again until the next time you 
install a Rockton product. 

file:///C:/Current%20Builds/Toolbox2015b8/Extras/www.rocktonsoftware.com
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Rockton Software Support window 

 

This window can be opened by clicking the Help icon ( ) and then choosing Rockton Software 
Support from the drop-list. 

Description 

This window will mostly be used by Rockton Support to get some high-level information 
about your system to assist in troubleshooting problems. You may also find some of the 
information presented here to be useful in your own troubleshooting.  

Clicking the What’s New button will drop-down a list of the Rockton products that you 
currently have installed which also have What’s New documents available. From this list, 
you can choose the product for which you want to see a list of new features in this build.  

The Installed Rockton Products section will show you your registration information. The 
Installed Build displays the version in the setup table. The Dictionary Build displays the 
version installed on the workstation. You can also see if the product is registered and 
when the registration is set to expire. 

If a product shows as not registered, select that product and then click the Register 
button to automatically attempt to register your products. If no registration exists, contact 
Rockton Software to resolve your registration issue. 

Another important feature of the Rockton Software Support window is the Support 
Options section at the bottom of the window. You can create a support case by clicking 
the Open a new Support Case link. This will open a browser window that will take you 
to the Rockton Software Partner Portal, where you can enter details of your problem. Or, 
if you wish to speak to someone in support first, or do your own research about your 
situation, you can click the Contact Support link and your Internet browser will be 
opened to our Technical Support page. Here, you will find various options for support 
including Manuals, FAQs, How-To Videos, Support contact information as well as other 
options. You can also see the Controlling Product in the Support Information field. This 
information can be helpful to support when troubleshooting. 
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Rockton Software Preferences window 

 
 

This window can be opened by clicking the Help icon ( ), choosing Rockton Software Support 
from the drop-list, and then clicking Settings and choosing Rockton Software Preferences. 

Description 

This window is used to assign specific preferences for Rockton Software products. 
Settings here will apply to all Rockton products you have installed. The window is broken 
into settings that apply to all users and settings that apply to specific users. 

When the Enable the ability to create Support cases check box is marked, users can 
create a support case from the Rockton Software Support window. When this option is 
enabled, a hyperlink to Open a new Support Case is available in the Rockton Software 
Support window. 

In the User-specific settings section, you can select a User and then mark the Enable 
check for newer builds at login. When marked and a user who is an administrator logs in, 
Rockton will check for any newer builds of the products installed. If the option is 
unmarked, no checks are made. It is recommended this option be marked for at least on 
Admin. user. 

The Registration check option allows you to choose whether to ask next time or ask 
tomorrow when looking for registration. 
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Dynamics GP Toolbox Setup window 
The Dynamics GP Toolbox Setup window allows you to perform setup and maintenance tasks. 

 

This window is accessible in one of these ways: 

• Log on as a User in the GP TOOLBOX ADMIN Security Role or the POWERUSER 
Security Role and go to Microsoft Dynamics GP > Tools > Setup > Dynamics GP Toolbox 
> Dynamics GP Toolbox Setup. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Dynamics GP Toolbox Setup from the Dynamics GP Toolbox 
sub menu. 

 

Description 

The Dynamics GP Toolbox Setup Setup window gives you access to all of the tasks you 
will need to configure and maintain the system.  It contains three tabs: 

• Setup  

• Troubleshooting  

• Uninstall  

You can see a brief description of each task by moving your cursor over any of the tasks 
in the list.  To select a task, simply click on the task name. 

Clicking the “Check RocktonSoftware.com for updates” link will take you to the 
Downloads web page for this product.  Here you can verify that you are installing the 
latest build. 

The tasks available for each tab are described in the following tables: 
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Setup tab 

Setup tasks help you configure and maintain Dynamics GP Toolbox. 

Task Description 

Registration Opens the window where you will enter a registration key. 

System Settings Opens the System Settings window.  This is where you can configure 
various options for Dynamics GP Toolbox. 

Import / Export Opens the Import / Export window.  This will allow you to save and 
restore values from Dynamics GP Toolbox tables. 

Login Log Maintenance Opens the Login Log Maintenance window.  This is where you can 
purge or archive the Login Log table. 

Recalculate Security Settings Opens the Recalculate Security Settings window, where you can 
rebuild the default Filters. 

Unlock Security Manager Only one user at a time can open the Security Manager window. 
However, there may be situations where Dynamics GP does not close 
properly (for instance, if you manually End Task on a Dynamics GP 
session).  If the Security Manager window happens to be open when 
this occurs, then it will remain “locked” and no Users will be allowed to 
use it.  This task is provided to resolve this situation. 

Import Filters from Security Auditor Opens the Import Filters from Security Auditor window where you can 
bring over any Filters that you had created in Rockton’s Security 
Auditor product into Dynamics GP Toolbox. 

Install/Upgrade Dynamics GP 
Toolbox 

Installs the software, or upgrades it from a previous version.  This 
may take several minutes.  It will also set table permissions to all 
users in the system database.  You can perform this task multiple 
times without causing any problems. 

Troubleshooting tab 

These tasks are for troubleshooting only. You may be asked to use them by Rockton Support. 

Task Description 

Rebuild Mentor Search Tables Rebuilds the tables that the Mentor tool uses to perform its searches.  
These tables contain information about the windows and menus that 
are found in each product that is installed. 

Re-add Security Data Adds Security Roles and Tasks for this product, if they were deleted. 

Move to First Position Moves Dynamics GP Toolbox to the first position in the launch file 
after Dynamics GP. 

Remove from Launch File Removes Dynamics GP Toolbox from the launch file. 

Rebuild Menus Rebuilds menu navigation for Dynamics GP Toolbox by first removing 
all menus from the Menu Master table.  To complete the process you 
must log in again to see the rebuilt menus. 

Rebuild Toolbars Removes and recreates default toolbar items for this product. 

Open Activity window Opens the Activity window, which will show debug messages in real 
time. 

Open Triggers window Opens the Triggers window, which will show Dexterity-based triggers 
as they are registered and unregistered in real time. 

Enable or Disable Script Logging Start or stop script logging, either immediately or beginning with the 
next time you log into Microsoft Dynamics GP from this workstation. 

Diagnostics Mode This option may gather diagnostics, create log files, open the Code 
window or other things that may be helpful to Rockton Support. 

Uninstall tab 

These tasks can be used to uninstall this product from the system or just from this workstation. 

Task Description 

Workstation Uninstall Removes Dynamics GP Toolbox from the launch file.  Also removes 
settings from the Defaults file. 

Complete Uninstall Dynamics GP Toolbox tables will be removed from the database(s) 
and the product will be removed from the launch file. 
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Enable or Disable Script Logging window 

Rockton Software Support may request that you use this window to help troubleshoot an issue. 

 

You can get to this window by going to Microsoft Dynamics GP > Tools > Setup > SmartFill > 
SmartFill Setup.  Then, from the Troubleshooting tab, choose Enable or Disable Script Logging. 

Description 

The Enable or Disable Script Logging window will allow you to create a special log file 
called a “script log”.  This may be requested by Rockton Software Support if the case 
you have reported is a tricky one.   

In the past, you used to have to update your Dex.ini file to add the line 
“ScriptDebugger=TRUE”, then log in to GP and use the Debug menu to create a script 
log.  Then when you were done logging, you would need to set the ScriptDebugger 
setting to FALSE so that the Debug menu would no longer show.  This window allows 
you to perform the same task without needed to update the Dex.ini.   

You will usually be given detailed instructions for how to use this window by a Support 
representative, but the general process will be similar to the following: 

1. Select either Immediate or At Next Login for Log Type. 

2. Enter or select the name and location of the log file that you are going to create. 

3. Perform whatever steps are necessary in Dynamics GP to get to a point 
immediately before you want to start capturing information in the log file. 

4. Click the Start Logging button on this window. 

5. Perform the steps that you want to log. 

6. Click the Stop Logging button on this window. 

7. Click the Open button to view the created log file, and/or email the file to Rockton 
Software Support. 
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Dismissed Dialogs window 
 
This window allows you enable, disable and configure individual tools. 

 

 
You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> 
Dismissed Dialogs. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Dismissed Dialogs from the Dynamics GP Toolbox sub 
menu. 

 

Description 

Some alert messages in Dynamics GP Toolbox will have a check box in the lower-left 
corner that is labeled, “Don’t show this message again.”  Checking this box will cause 
that message to not be displayed the next time you perform that action.  However, if you 
later wish to have that message displayed again, you can change that setting on the 
Dismissed Dialogs window.   

When you first enter this window, the messages that you have dismissed will be 
checked.  If you uncheck a message, then that message will show the next time you 
perform the action associated with it. 

Similarly, any unchecked messages can be dismissed here by checking the respective 
check box. 

Messages are dismissed by User, so changing these settings will only affect what you see, 
not what any other Users see. 
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The messages that can be enabled and disabled in this way are described in the 
following table: 

Message Description 

Tool Enable message When you enable or disable a tool from the System Settings 
window, you will see this message: 

“Menu items for this tool may not reflect this change until 
the next time you log on to Microsoft Dynamics GP.” 

Child window message If you attempt to open a child window from the Mentor search 
results window, you will see this message: 

“This window is a child window.  Its parent window, 
'<window-name>', will open instead”. 

No menu navigation exists 
message 

If you attempt to open a window from the Mentor search results 
window, and it is not directly accessible from any Dynamics GP 
menu, you will see this message: 

“No menu navigation exists for the '<window-name>' 
window.  Opening it directly could possibly have 
unpredictable results.  Do you want to continue?”   

You will be given the option to choose either Yes or No.  If you 
check this box you will disable this alert message.  You will also 
then be able to choose the option Yes or No. 

Power User message On the Security Settings window, if you attempt to change Security 
access for a User that is in the POWERUSER Security Role, you 
will see this message: 

“This user is a Power User.  Granting or revoking access 
to the <role-name> Role will not change the things to 
which this User has access.” 

Inspector initialization message When you start the Inspector tool, you will see this message: 
“Inspector is now active.  To get information about the 
fields and tables on a window, open that window now.  
Inspector will remain active until you click the Done button 
on the Inspector window.”  

Add Activity Controls initialization 
message 

When you start adding Activity Controls by clicking the ‘+’ icon on 
the Timeout tab of the System Settings window, you will see this 
message: 

“To add buttons or fields from a window to the list of 
Activity Controls, open that window now.  When you are 
done, close that window and the controls you selected will 
be added.”  
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Dynamics GP Toolbox Import / Export window 
 
This window allows you import or export data from Dynamics GP Toolbox. 

 

 
You can access this window by first opening the Dynamics GP Toolbox Setup window, then 
choosing the Import / Export task from the Setup tab. 
 

Description 

The Import / Export window can be used to transfer data in and out of Dynamics GP 
Toolbox.  At this time, only a select group of tables is available to import or export. 

The naming convention used for the export or import files is as follows: 

RSTB_BACKUP_Toolbox_<table-name>.xml 

where <table-name> is the name that shows in the Tables list, but with underscores in 
place of spaces. 
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Exporting data 

Tables will be exported in XML format.  The export file will consist of all records in the 
selected table.   

To export one or more tables: 

1. Select or enter the location of the folder where you want the export files to be created. 
2. Select the Export radio button in the ‘Import or Export’ radio group. 
3. Mark the table or tables that you want to export.  Note that you can use the Mark All and 

Unmark All buttons to the upper-right of the Tables list. 
4. Click the Export button. 

 

Once the Export completes, the record count for each exported table will show in the 
Tables list. 

Importing data 

When you import an XML file in this format, you will see a Replace Option radio button 
group.  The options available are: 

• Add new records only – this will ignore any duplicates that are found 

• Delete existing records, then import – this will remove all records from the 
table you are importing into first.  In effect, you will be replacing the contents of 
the table with what is in the XML file you are importing. 

To import one or more tables: 

1. Select or enter the location of the folder that contains the XML files to be imported. 
2. Select the Import radio button in the ‘Import or Export’ radio group. 
3. Select the desired option from the ‘Replace Option’ radio group. 
4. Mark the table or tables that you want to import.  Note that you can use the Mark All and 

Unmark All buttons to the upper-right of the Tables list. 
5. Click the Import button. 

Once the Import completes, the record count for each imported table will show in the 
Tables list.  If you have chosen Add new records only from the ‘Replace Option’ radio 
group, then you will see a count of the records added along with a count of the 
duplicates that were found, if there were any, for each table selected. 
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 Import Filters from Security Auditor window 
 
This window allows you to import Filters from Rockton’s Security Auditor product. 

 

 
You can access this window by first opening the Dynamics GP Toolbox Setup window, then 
choosing the Import Filters from Security Auditor task from the Setup tab. 
 

Description 

If you have previously used Rockton’s Security Auditor product, then you may have 
created custom Filters for that product’s Security Manager window.  You can make these 
Filters available in Dynamics GP Toolbox as well by using the Import Filters from 
Security Auditor window.  

In order for this import process to function correctly, these conditions must be met: 

• Four Security Auditor tables (RSSA001, RSSA014, RSSA016 and RSSA017) 
must exist on the DYNAMICS database 

• The version of Security Auditor that is installed must be at least 10.0 

Any custom Filters that have been defined in Security Auditor will be listed.  You can 
select as many Filters as you want to bring over into Dynamics GP Toolbox.  You can 
also use the Mark All and Unmark All buttons to make the selection process easier. 

If the name of any of the Filters listed matches the name of a Filter that has already been 

created in Dynamics GP Toolbox, then you will see “Filter already on file” in the 

Message column.  You can still import these Filters if you want to, but you will be 

prompted to enter a new Filter Name when you click the Import button. 
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Once you have made your selections, click the Import button and the selected 
components will be copied to Dynamics GP Toolbox.  When you close this window, you 
will be presented with the Uninstall Security Auditor window.    

 

All of the features of Rockton’s Security Auditor product are now available in the 

Dynamics GP Toolbox and Auditor products.  

It is recommended that you uninstall Security Auditor as soon as possible after you have 

copied over any data and settings into Dynamics GP Toolbox and, if applicable, Auditor.  

This will prevent any confusion that may occur due to the overlapping functionality 

between these products. 

If you are ready to uninstall Security Auditor at this time, click the Uninstall button.  
Otherwise click OK to close this window.    
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Recalculate Security Settings window 
 

 
 

This window is accessible in one of these ways: 

• Open the Dynamics GP Toolbox Setup window.  From the Setup tab, choose Recalculate 
Security Settings. 

• Open the Security Manager window.  Then choose Recalculate from the Options menu.   

Description 

The Recalculate window is used to rebuild the default Filters.  You should only need to 
use this window if you have installed new integrating products into your Dynamics 
environment, removed integrating products, or if you have made changes to reports or 
windows using the Report Writer or Modifier customization tools.  

• Modifications: if you have imported or created any forms with Modifier, including 
in 3rd party products, include this option to rebuild the z.ALT-MOD IDS default 
Filter. 

• Security Objects: if you have added a new integrating product, or removed one, 
include this option to refresh all other default Filters.   

It is not recommended that you clear or select the individual options underneath security 
objects unless instructed to do so by Rockton Software Support. 
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Dynamics GP Toolbox System Settings window 
 
This window allows you enable, disable and configure individual tools. 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> System 
Settings. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select System Settings from the Dynamics GP Toolbox sub menu. 

Description 

The Dynamics GP Toolbox System Settings window is where you will configure any tool 
that has settings to be configured.  You can also enable and disable these tools here.   

The window has five Tool Group icons at the top: 

•  Home 

•  Security 

•  Administration 

•  Business Processes 

•  User Experience  

Selecting a Tool Group will show the tabs for the tools in that Tool Group.  The Tool 
Groups and the tools available for each are described on the following page. 
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Home  

Settings is the only tab for the Home group.  Enable or disable any of the tools listed by clicking 

the icon to the left of the tool name.  means the tool is enabled;  means it is disabled. 

If you click on the name of a tool, a brief description of that tool will appear to the right.  You can 
also navigate directly to a tool’s settings tab by double-clicking the tool name. 

Security               Tools that make the system more secure.  

Tool Name Description 

Password Policy 
Options 

Provides Password Restrictions, to both User passwords and the System 
password, above and beyond those provided by Microsoft Dynamics GP. 

Inactivity Timeout Allows a workstation to be gracefully logged out of Microsoft Dynamics GP 
after a pre-defined period of inactivity. 

User Lockout Lock Users out of Microsoft Dynamics GP after they have made the specified 
number of unsuccessful password attempts. 

Safe Login Prevents users from doing anything immediately after logging into Microsoft 
Dynamics GP until all products have completely initialized. 

Redirect Allows you to assign a different window to open when a User does not have 
Security access to a given window. 

Security Manager Allows you to view, report on, and manage security in a much more intuitive 
interface than is available with Dynamics GP. 

Administration    Tools that help the System Administrator perform various tasks. 

Tool Name Description 

Version Pro Allows easier maintenance and version control over multiple 3rd Party 
products on multiple workstations on your Microsoft Dynamics GP network. 

Login Logging Track actual logins against the Microsoft Dynamics GP Registered User 
count. 

System Lockout Allows a system administrator to prevent users logging into a specified 
company or all companies. 

Business Processes      Tools that improve specific modules in Dynamics GP. 

Tool Name Description 

Reason For Hold Forces the User to enter the reason that they are putting a Customer or 
Vendor on Hold. 

DocSync Allows you to retain all or part of a transferred Sales document ID in the 
resulting document ID. 

Payment Approval Provide auditing and multi-level approval of payments in Dynamics GP. 

User Experience          Tools that make using Microsoft Dynamics GP easier and simpler. 

Tool Name Description 

Mentor Search for, open and get info about windows in Microsoft Dynamics GP. 

Inspector Gives detailed technical information about the fields in any window in 
Microsoft Dynamics GP or any Dexterity-based product that integrates with it. 

PopUps Display information and/or Tips of the Day to the user on virtually any window 
in Microsoft Dynamics GP. 

Widgets Simple, yet powerful tools that improve the experience in Microsoft Dynamics 
GP.  The following widgets are available: 

• Microsoft Dynamics GP Close Confirmation 

• Company In Title Bar 

• Auto Fill System Password 
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Password Policy Options 
 

 

Description 

Password Policy Options provides password restrictions similar to those available in 
Microsoft Windows.  These options can be applied to both User passwords and the 
System password.  The following options are available: 

Password Policy Option Description 

Expiration Controls how soon passwords need to be changed. 

Allow Changes Controls how long a password must be in effect before it can be 
changed.  Prevents passwords from being changed too often. 

Minimum Password Length Sets the minimum length of a password. 

Password Uniqueness Controls how many unique passwords must be used before you 
can reuse an old password. 

Changed Characters Controls how different passwords must be from previous 
passwords. 

Numeric Characters Controls how many numeric characters passwords must contain. 

Symbolic Characters Controls how many symbolic characters passwords must contain.  
Symbolic characters are any characters other than letters or 
numbers. 

Force Mixed Case Forces passwords to contain at least one lower-case and one 
upper-case alphabetic character. 

Warning Period Displays a warning to the User before their password expires. 

Grace Period Allows a User to login a specified number of times after their 
password has expired. 

You can change these settings by selecting an option and then clicking the ‘+’ or ‘-‘ 
buttons at the top of the Password Policy Options list box.  Alternatively, you can double-
click the option and enter the new setting value in the Option Setting dialog box. 
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Leaving the Warning Period and Grace Period options as ‘Do not Warn’ and ‘Login denied 
if password expired’ is not recommended as users will be suddenly locked out of Dynamics 
GP, and can only be let back in by the System Administrator. 

If the ‘Apply Password Restrictions to System Password’ checkbox is selected, these 
options will apply to the System Password as well. 

If the ‘Allow Clearing of Password History by Administrator’ checkbox is selected, you 
will be prompted to clear password history when you focus to the Password fields on the 
User Setup window. 

You can disable Password Policy Options for a given User or Company by adjusting your 
Dynamics GP Security settings.  To do this, remove the Password Policy Tool from the 
DEFAULTUSER Security Task and then assign it to any task that suits your needs. 
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Inactivity Timeout 
 

 

Description 

Inactivity Timeout monitors activity and attempts to gracefully log a User out of Microsoft 
Dynamics GP if they have not had any activity for the specified time period.  There are a 
number of ways that you can customize how this tool behaves: 

• You can specify a system-wide timeout limit that applies to all users by default. 

• You can also override the system-wide timeout limit for any number of User 
Groups (see User Group Setup window for more on creating User Groups).  

• You can set up a weekly schedule that defines when the tool is active. 

• You can select multiple User Groups to be excluded from Inactivity Timeout. 

Default Minutes Inactive Before Timing Out is the system-wide timeout limit.  Once a 
user is inactive for more than the number of minutes entered here, they will be logged 
out of Dynamics GP.  This limit applies to any user that is not in a User Group that has 
its own timeout limit specified. 

The Clear Stranded Activity Records box allows clearing User Activity table 
(ACTIVITY) records that were left stranded when a terminal session was cancelled 
without exiting Dynamics GP first. By checking this box, users logged into Dynamics GP 
will remove any records in the ACTIVITY table if the following is true: 

• the record has been there longer than the Inactivity Threshold for that user (see 
the Clear Stranded Records Lag Time section below); 

• the user removing the ACTIVITY record has sufficient SQL permissions to 
disable and enable triggers on a table. 

file:///C:/Current%20Builds/Toolbox2016b8/Extras/Dynamics%20GP%20Toolbox%20Manual.docx%23_User_Group_Setup_1
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Settings by User Group 

This is where you can specify the customizations mentioned above.  You do this by 
adding a User Group to the tool, and then assigning settings to that User Group.  A User 
Group can be added as either an Included group or an Excluded group.  The users in an 
Included group will be subject to the Inactivity Timeout.  However, the users in an 
Excluded group will remain logged in regardless of the timeout limit setting, so therefore 
are not subject to the timeout.   

To add a User Group, click the Add User Group button ( ).  This will open the User 
Groups lookup window, where you can select the group that you want to add.  This 
group will be initially added to the tool as an Included group with the default settings.  If 
you want to modify the default behavior for this group, or change it to an Excluded 
group, simply select that User Group in the list and click the Edit User Group button ( ).  
This will open the Inactivity Timeout User Group Settings window: 

 

From here you specify a different timeout limit (Minutes Inactive Before Timing Out), or 
set up a Schedule for when the tool should be active for this User Group (see the section 
on the Schedule Setup window for more information about creating a schedule).  You 
can also choose to make this group an Excluded group by simply changing the User 
Group Type at the top of the window.  Note that you may not specify any other settings 
for an Excluded group. 

You can remove a User Group from the tool by selecting it in the list and clicking the 

Remove User Group button ( ).  This does not delete the User Group from the system; 
it simply detaches it from the Inactivity Timeout tool. 

You can disable Inactivity Timeout for a given User or Company by adjusting your 
Dynamics GP Security settings.  To do this, remove the Inactivity Timeout Tool from the 
DEFAULTUSER Security Task and then assign it to any task that suits your needs. 

You can choose to see All User Groups, Excluded User Groups Only, or Included User 
Groups Only from the Show drop-down.  You can also choose “Settings by Individual 
User” to see whether or not a given user will be subject to the Inactivity Timeout.  This 
view will indicate, for each User in the system, whether they are Excluded or Included 
from the Inactivity Timeout.  If they are included, it will list which User Group is 
responsible for including them, along with that group’s timeout limit settings. If they are 
excluded, it will list which User Group is responsible for excluding them.  This can be 
very useful in troubleshooting. 
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Advanced Settings 

There are some Inactivity Timeout settings that are not used very often.  Click the 
Advanced button in the ribbon of the System Settings window to open this window: 

 

Periodic Check Priority allows you to set the priority of the timed task that checks each 
User for activity (RSTB_Timeout_PeriodicCheck).  This can be useful in cases where 
this task is holding up other, more urgent timed tasks that you may have running.  The 
default value is 50. 

Clear Stranded Records Lag Time is used by the Clear Stranded Activity Records 
feature of this tool (see above). It allows you to set the number of minutes that the 
system will wait after a user’s assigned Inactivity Threshold before it deletes records 
from the User Activity table (ACTIVITY). The default is 120 (two hours). 

The Log Activity option can be used to troubleshoot any problems with the Inactivity 
Timeout tool.  Checking this box will cause any activity to be written to a table which can 
be viewed on the User Activity Log Inquiry window.   

Use care when using this option because it will likely increase processing time.  Any time 
any activiy happens, including accessing tables, opening windows and running reports, 
among other things, a record will be written to the log table.  Be sure that you uncheck this 
option when you are done troubleshooting. 

Add Exceptions for timed tasks 

Occasionally an integrating product will have a timed, background task that performs 
table accesses.  Since table accesses are considered “activity”, this will usually cause 
the activity timers to be reset, thus impeding the Inactivity Timeout tool.  One way to 
combat this is to ignore table accesses that happen during any of these timed tasks.   
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For this reason, we have provided the Inactivity Timeout Exceptions window, which is 
accessed by pressing the Exceptions button: 

 

When you install Dynamics GP Toolbox, this window will be preloaded with any products 
that we have identified already as needing to be excluded from the Inactivity Timeout 
tool.  However, if you find that another product’s timed task is causing a problem, you 
can add it here by clicking the Add Exception button (+).   

 

You can determine the Script Name by opening the Process Monitor (File > Process 
Monitor), selecting the task you want to add from the Timed Queue, and then choosing 
the Detail button.  The Product ID and Form Technical Name may be a little trickier and 
may require some internal, technical knowledge of Dynamics GP and the products that 
you have installed on your system.   

Since this is an advanced function that you will rarely, if ever, need to use, please feel 
free to contact Rockton Software Support for assistance in adding a new Exception. 
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Additional Activity Controls 

Rarely, you may find you are logged in and working on certain windows and you get 
logged out by the Inactivity Timeout tool, even though you were doing things.  This is 
often due to a couple of common causes: 

1. Some windows are written in such a way that they may not perform any table 
accesses, except when the window is first loaded 

2. Some windows may not contain any of the common buttons that the Inactivity 
Timeout tool looks for.  Or, if they do, then they are not the same buttons that 
most Dynamics GP windows use.  Instead, they are buttons that were created 
specifically for that window. 

Accessing tables, opening windows and running reports, among other things, is always 
considered “activity”.  In addition, clicking some common buttons, such as Save, Cancel, 
OK and navigation buttons, will also generally be conisdered activity. 

Fortunately, there is a way that you can tell the Inactivity Timeout tool to look for 
interactions with other buttons on certain windows and to consider those interactions to 
be “activity.”  This is done by adding Additional Activity Controls as follows: 

1. To get started, click the ‘+’ icon to the upper-right of the Additional Activity 
Controls list box.  The Add Activity Controls window will open, as well as a 
message instructing you to open the window for which you want to specify 
additional controls. 

2. Once you open the desired window, 
click on the button or other control on 
that window that you want to be 
considered as “activity.”  You will notice 
that the names of each field that you 
click on or tab to will show up in the 
Control field on the Add Activity 
Controls window.   

3. When you have clicked on the button 
you want to add, click the Add Control 
button.  You can add as many buttons 
or fields (controls) as you like on this 
window.   

4. When you are done, close the window 
you opened in step 2.  You will see that 
the controls that you added are now in 
the Additional Activity Controls list box 
on the Inactivity Timeout tab of the 
System Settings window. 

5. You can now repeat this procedure if 
there are other windows for which you 
need to add Activity Controls. 
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User Lockout 
 

 

 
Description 

The User Lockout tool adds the ability to lock Users out of Dynamics GP after they have 
unsuccessfully attempted to log in a specified number of times. Normally, after entering 
your password incorrectly three times in a row, the Login window will close. However, 
you can simply open it again and try three more times, and so on.  User Lockout actually 
keeps the User from logging in until an Administrator has unlocked them. Furthermore, 
you can specify the number of unsuccessful attempts before a user is locked out, rather 
than relying on this functionality to be invoked after three attempts. 

Once you enable this tool, you must enter a location for the Locked Users table.  As 
stated on the Lockout tab of the System Settings window, this is the location of a Ctree 
table that will be used to keep track of any Users that have been locked out.   

This location should be specified as a UNC pathname to which everyone in the 
system has update access. 

DO NOT attempt to manually move or change this table or change the Dex.ini 
settings associated with this feature in any way.  Doing so will cause ALL Users 
to be locked out of the system!  If you need to move this table, then select or enter a 
new location for it on the Lockout tab of the System Settings window. 
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Once a User becomes locked out, an Administrator can unlock them via the Unlock 
Users window.  This window can be accessed by going to Tools >> Setup >> Dynamics 
GP Toolbox >> Unlock Users.   

 

When unlocking a User, you will be given the options to generate a new password 
and/or force the User to change their password the next time they log on.   

It is recommended, from a security standpoint, that you use both of these options 
when you unlock a locked User ID. 

The new, generated password can be seen by choosing View History from the View 
drop-down.  You will now see a radio group that gives you the option to show only the 
most recent time that each User was locked out, or all lockouts for each User.   

 

If you have chosen to have the system generate a password when unlocking a User, you 
can also select that User and email this generated password to them.   

There are also reports to show currently locked Users and history as well. 
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Safe Login 
 

 

Description 

Safe Login prevents Users from interacting with Microsoft Dynamics GP until the login 
process has completed.  Without Safe Login, a User can start to open windows and do 
things before all of the products in their launch file have been completely initialized.  This 
can result in 3rd party functionality not being available on some windows. 

To keep this from happening, simply enable Safe Login.  When you log in, you will now 
see the following dialog box and you will not be able to do anything in Dynamics GP until 
the login has completed: 

 

You can also optionally enter the message that will show on this window, as well as 
change the text and window background color.  To change colors, click the Window 
Options button and select the colors you would like to see, then click the Preview button 
to see how it looks.  You can set colors back to Default if you don’t like what you see! 

The Disable Sample Company Date Message option will disable the alert message 
that opens when you log in to the Fabrikam Sample Company.  We recommend using 
this option if you find that your cursor loses focus during the login and you cannot click 
the OK button on this alert message.   



Rockton Software Dynamics GP Toolbox, 3/19/2024  53 

Redirect 
 

 

 
Description 

There are often instances where a User may have access to a transaction or inquiry 
window, but not Cards.  What this means is these Users are not able to take advantage 
of the zoom capability that is built into many windows in Dynamics GP.  Examples of this 
would be the Customer zoom on the Sales Transaction Entry window, or the Vendor 
zoom on the Payables Transaction Inquiry windows.  When such a User clicks on the 
zoom link, they simply get an ugly “access denied” message. 

The Redirect tool allows you to specify another window to open when a User does not 
have access to the window that Dynamics GP would normally open.  In the screen 
image above, you can see that the User will be redirected to the Vendor Inquiry window 
when they attempt to zoom on the Vendor ID.   

We have pre-defined many of the most common of these situations for you, however you 
can always add more if you find the need.  Also, if you find that there are situations that 
we have not covered in our pre-defined set of Redirects, please let us know and we will 
try to get them included! 
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Adding a Redirect 

Follow this procedure to add your own Redirect: 

1. Click the ‘+’ button at the upper-right of the Redirected Windows list box on the 
Redirect tab of the System Settings window.  This will open the Add Redirect 
Window window. 

 

2. Enter the name of the window that you want to Redirect From.  This is the 
window that the User does not have access to.  You can also enter only part of 
the name, for instance “vend maint”. 

3. Click the Mentor Search button ( ).  Mentor will search for the window that you 
entered.  If it does not display the desired window, try opening the drop-down 
and you will probably find it in the list.  If you don’t find it, try entering a little more 
of the name and click the Mentor Search button again. 

4. Enter the Redirect To window using the same procedure.  The Redirect To 
window is the window that you want to open instead of the Redirect From 
window.  Keep in mind that the User must have Security access to this window in 
order for the Redirect to take effect. 

5. Enter the Source Window.  This is typically the window that contains the zoom.  
This window will also be used to carry over any fields needed to display the 
correct data on the Redirect To window.  In this case, we will bring over the 
Vendor ID to the Vendor Inquiry window.  This will happen in the next step. 

6. Click the Add button.  You will be asked if you would like to populate the To 
Window with values from the Source Window.  If you choose No, then the 
Redirect To window will open in its initial state, with no data displayed.  However, 
in most cases you will want to choose Yes.  If you do, the Redirect Maintenance 
window will open. 

The Redirect Maintenance window is where you will specify the fields that need 
to be brought over from the Source Window in order to display the desired data 
on the To Window.   
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7. If the Source Window contains a scrolling window, you will see the Scrolling 
windows drop-down list.  Select the window that contains the field that you want 
to bring over to the To Window.  The Fields list boxes should redisplay 
accordingly. 

8. Scroll down in the Source Window’s Fields list box to find the field you want to 
bring over to the To Window.  Once you find it, select that field. 

9. In the Fields list box for the To Window, search for the field that will be populated 
with the field you selected in the previous step.  Select that field. 

10. Click the Link button.  You have now populated the selected field on the To 
Window with the value of the field on the Source Window.  A red circle icon will 
appear next to each selected field to show you that they are linked to each other.   

11. You can repeat steps 7 thru 10 to populate the To Window with additional fields.  
As you link these fields, their icons will each be a unique color so you can tell 
which field on the Source Window goes with which field on the To Window.  
There are up to 16 different colors that will be used for linked fields.  After 16, 
each icon will be a black circle.  However, you can still tell which fields are linked 
simply by clicking on either one; the corresponding linked field in the other Fields 
list will become visible and will be selected. 

12. When you are done, click the OK button.  Your Redirect is now complete. 
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Security Manager 
 

 

 
Description 

The Security Manager window (described in detail later) allows you to view, report on 
and manage security in a much more intuitive interface than is available with Dynamics 
GP.  This tab gives you options for how certain aspects of the window will look, and how 
certain actions such as double-clicking a line will behave.   

The Security Manager tool requires certain tables to be loaded with all of the resources 
(windows, reports, tables, posting permissions, etc.) in each of the products in Dynamics 
GP.  When you enable the Security Manager tool for the first time, these resource tables 
will be built at that time.  Note that this process may take some time to complete.  

If you have Rockton’s Auditor product installed, and Segregation of Duties 
Groups have been set up, you can choose to show any Segregation of Duties 
conflicts in the Security Manager window.  Any mention of Segregation of Duties 
conflicts in this document only applies if you have Auditor installed and have set up 
Segregation of Duties Groups. 

You may wish to review the Security Manager window section before proceeding to the 
following sections so that the terms mentioned below will make sense.
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General options 

Update tree navigation when selecting from list.  By default, selecting an item in the 
tree will highlight the corresponding line and section of the security grid.  By checking 
this option, when you highlight a line in the security grid, the tree on the left will 
automatically display the corresponding security object.  This keeps the two panes 
constantly synchronized. 

The Double-clicking a cell option has three settings: 

• Toggles Security if simple, zooms if options. If there are no Modified or 
Alternate windows, and no Segregation of Duties conflicts, it will toggle between 
Yes and No.  Otherwise, the Security Detail Zoom window will open and allow 
you to change security settings on an individual basis. 

• Toggles Security.  Always toggle security between Yes and No. 

• Zooms to detailed security settings.  Always opens the details zoom window. 

List Appearance Options 

Show Index column.  This shows a line number as the first column in the security grid. 

Show Icons.  You can choose whether or not to show Icons in the security grid.   

Indent options has two settings: 

• Indent. Indent the list portion of the security grid to match the tree hierarchy. 

• Indent With Markers.  Similar to Indent, but instead of spaces, a greater than 
sign (>) will be used to mark each level that is indented. 

Display Optimization Options 

The Display Optimization option has three settings: 

• Ask Each Time.  Whenever you perform an action that causes the Security 
Manager to redisplay, if Display Optimization is not currently active, you will be 
asked whether or not you want to start Display Optimization.  Actions that cause 
the window to redisplay include selecting a new Filter and clicking the Redisplay 
button on the Security Manager window. 

• At the Login. If you choose this option, then as soon as you login to Dynamics 
GP, the Display Optimization cache will start to be loaded in the background. 

• When you open Security Manager. If you choose this option, then whenever 
you open the Security Manager window, if the Display Optimization cache is 
empty then it will start to be loaded in the background. 

• Never use Display Optimization.  The cache will never be automatically loaded. 

The Load Cache button allows you to manually load the Display Optimization cache 
whenever you want.  The Clear Cache button similarly clears the cache. 
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Show Users with Security update privileges 

Clicking the Privileges button will open the Users with Update Privileges window.  This is 
where you can see which users have the ability to make changes to security settings on 
the Security Manager window.  All other users that have access to this window will be 
able to view security settings, but not change them.  This can be useful for Auditors to 
review and print security settings. 

 

 

 

Only users that have security access to the User Security Setup window in 
Dynamics GP will have privileges to make changes on the Security Manager 
window.  Therefore, in order to allow a user to make changes on Security Manager, 
you must grant them access to the User Security Setup window. 
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Version Pro 

 

 
Description 

Version Pro allows easier maintenance and version control over multiple 3rd Party 
products on multiple workstations on your Dynamics GP network.  See the Version Pro 
section later in this manual for more details on using Version Pro. 

One or more System Administrators should be specified.  When logged in as a Version 
Pro System Administrator, certain additional functions and features become available 
that are not typically available to the average User.  For instance, when version conflicts 
occur, an email can be sent to the System Administrators.   

To enable this feature, double-click each User that has been selected as a System 
Administrator.  This will open the Version Pro Administrator Additional Information 
dialog, where you can enter an email address for that System Administrator.  In addition, 
you must also have one or more of the “Email Administrator” checkboxes marked. 

You can optionally choose to specify the message that the User sees at the login when 
there is a version conflict.  Enter this message in the ‘Message to display to user when a 
version conflict occurs’ box.  If this field is left blank, the default message will appear.  

Version Pro verifies upon login that all products required by the system are loaded and 
are on the current version.  There are also several optional features that you as an 
Administrator can choose to make available to your Users.  Logging of incorrectly 
configured workstations is ideal for centralized management and control.  And as a 
system administrator, you can force users to exit the system when they are not operating 
with the correct products or versions loaded.  These optional features are described in 
the tables on the following page. 
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When a required product is missing from a workstation 

Products can be marked as optional or required in the system registry.  If a user logs in 
and does not have a required product installed at their workstation, Version Pro will 
detect it.  Select what you would like to occur from the following options: 

Option Description 

Force User to Exit System If the user is unable to resolve the conflict (which is likely since 
they are missing a product), checking this box will force the user 
to exit the system until they correct the problem.  However, 
Version Pro will inform the user what the problem is and give 
them opportunity to fix the problem on their own.  

Log the Occurrence in the System Log Record this incident in the system log. 

Allow User to Update System Registry 
(make product optional) 

Checking this box will enable a user to determine for himself or 
herself that the product they don’t have loaded is indeed an 
optional product, and therefore not necessary for them to have.  
Checking this box will allow them to update the system registry 
entry for the specific product not loaded at their workstation.  It 
will only update the Optional status for that product. 

Email Administrator Emails details to an Administrator when there is a conflict. 

When a workstation product version conflicts with the system registry 

For a given product, such as SmartList, the system registry may have version 7.5.4 while 
the workstation from which the user logs in has the older version 7.5.3 loaded (or even a 
newer version such as 8.0.1).  Version Pro will detect these version conflicts.  

Option Description 

Force User to Exit System If the user is unable to resolve the conflict (which is likely since 
they usually need to exit the system and load the current 
version), checking this box will force the user to exit the system 
until they correct the problem.  However, Version Pro will inform 
the user what the problem is and give them opportunity to fix 
the problem on their own.  

Log the Occurrence in the System Log Record this incident in the system log. 

Allow User to Update System Registry 
(with workstation version) 

Checking this box will enable a user to determine for himself or 
herself that the specific product in question that they have 
loaded is indeed the correct and current version.  Checking this 
box will allow them to update the system registry entry for the 
specific product in question.  It will only update the major, minor, 
and build numbers for the product, overwriting the system 
registry with the values loaded at the workstation. 

Email Administrator Emails details to an Administrator when there is a conflict. 

When a workstation product is not in the system registry 

Products in the system registry can be optional or required.  Version Pro will detect when 
a user logs in and does not have a required product installed at their workstation.  

Option Description 

Force User to Exit System If the user is unable to resolve the conflict checking this box will 
force the user to exit the system until they correct the problem.  
However, Version Pro will inform the user what the problem is 
and give them opportunity to fix the problem on their own.  

Log the Occurrence in the System Log Record this incident in the system log. 

Allow User to Update System Registry 
(by adding product) 

Checking this box will enable a user to determine for himself or 
herself that the product they have loaded at the workstation is 
new and needed on the network.  Checking this box will allow 
them to update the system registry by adding a new entry for 
the new product loaded at their workstation. 

Email Administrator Emails details to an Administrator when there is a conflict. 
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Login Logging 
 

 

Description 

The Login Logging tool allows you to track actual logins against the Dynamics GP 
Registered User count.  You can log when a User is denied entry because the Dynamics 
GP User limit has been reached.  Additionally, you can specify a threshold lower than 
the Dynamics GP Registered User Count in order to log when this User count is 
reached.  In either case, you can send a message to an optional email address when 
logging occurs.   

See the Login Logging section later in this manual for more details on Login Logging. 



Rockton Software Dynamics GP Toolbox, 3/19/2024  62 

System Lockout 

 

Description 

The System Lockout tool will prevent users from logging in to the accounting system.  It 
will also force users already logged in to exit.  You may schedule future lockouts or 
activate the lockout immediately.  An individual Company can be locked out, or you can 
lock out All Companies at once.  You can also exclude Users from the lockout. 

When you enable System Lockout, you will be required to select at least one User 
Group.  The Users in these groups are the only ones who will still be allowed back into 
the system when System Lockout is taking place (see the User Group Setup window 
section for details on creating and managing User Groups).  To add User Group to the 
list, click the Add User Group button ( ) and select one from the User Groups lookup.  
Click the Edit User Group button ( ) to modify the Users that belong to a selected User 

Group.  Click the Remove User Group button ( ) to remove a User Group from the list. 

You can choose “Settings by Individual User” from the Show drop-down to see whether 
or not a given user will be subject to the System Lockout.  This view will indicate, for 
each User in the system, whether they are Excluded or Included from the System 
Lockout.  If they are excluded, it will list which User Group is responsible for excluding 
them.  This can be very useful in troubleshooting. 
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Activating a System Lockout immediately 

To activate System Lockout immediately: 

• Check the Enable System Lockout box. 

• Add at least one User Group to the list of excluded User Groups. 

• If you see “Active Schedule Exists” next to the Schedule button (see above), 
check the Lockout Timeframe box and clear out the “From” date and time fields.  
The “Until” date and time can be whatever is appropriate in your situation. 

• If you do not see the “Active Schedule Exists” message to the right of the 
Schedule button, simply uncheck the Lockout Timeframe box. 

• Click the OK button. 

If the Lockout Timeframe is not currently active, and the current date and time does not 
fall within any active Schedule Item in the Schedule, then you will see this message, in 
red, to the right of the Enable System Lockout checkbox: 

System Lockout is immediate. 

There are two ways to schedule a future System Lockout: you may specify the 
timeframe for a future lockout, or schedule a recurring, weekly lockouts.  If you specify 
both, then both types will be in effect when the tool is enabled. 

Scheduling a future System Lockout 

To schedule a single lockout for some point in the future, check the Lockout Timeframe 
box.  You will now be able to enter a “From” and “Until” date and time to specify when 
the lockout should start and end.  When the System Lockout tool is enabled, it will be in 
effect continuously during this time period. 

If a the current date and time falls within the specified Lockout Timeframe, and the 
Lockout Timeframe checkbox is marked, then you will see this message, in red, to the 
right of the Enable System Lockout checkbox: 

System Lockout is currently in effect because we are in the Lockout Timeframe. 

Scheduling recurring System Lockouts 

To schedule regular lockouts to occur during the week, click the Schedule button.  This 
will open the Schedule Setup window (see the section on the Schedule Setup window 
for more information on adding and maintaining a schedule). 

If the Lockout Timeframe is not currently active, and the current date and time falls within 
an active Schedule Item in the Schedule, then you will see this message, in red, to the 
right of the Enable System Lockout checkbox: 

A scheduled, recurring System Lockout is currently in effect.  Click the Schedule button 
for details. 
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System Lockout Advanced Settings  

Click the Advanced button in the ribbon of the System Lock tab of the System Settings 
window to open the System Lockout Advanced Settings window.  This is where you will 
set some of the less frequently used settings of the System Lockout tool. 

 

Periodic Check Priority allows you to set the priority of the timed task that will log active 
Users out of the system when you enable this tool (RSTB_Sysmnt_PeriodicCheck).  
This can be useful in cases where this task is holding up other, more urgent timed tasks 
that you may have running.  The default value is 50. 

An Optional Lockout Message can be displayed when denying login access or 
requesting a user to exit.  If this message is not entered, the default message will be 
used: 

 

You can also optionally change the text color and window background color.  To change 
colors, click the Window Options button and select the colors you would like to see, then 
click the Preview button to see how it looks.  You can always set a color back to Default 
if you don’t like what you see! 
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Reason for Hold 

 

 

 
Description 

The Reason for Hold tool will force the User to enter a reason for placing a Customer or 
Vendor on hold.  You can choose to enable this functionality for just Customers, just 
Vendors, or both. 

See the Reason for Hold section later in this manual for more details about this tool. 
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DocSync 

 

Description 

At different points in a transaction’s life, its Sales document can be transferred from one 
type to another, for instance from a Quote to an Order, and then from that Order to an 
Invoice.  DocSync gives you the ability to easily determine which Sales document a 
particular transaction was transferred from, simply by looking at the document number. 

DocSync allows you to specify a “mask” that will be used to construct the document 
number to which a transaction will be transferred.  Within this mask, you can choose to 
retain the entire original document number, or you can retain only the numeric portion.  
You accomplish this by including one of the “Mask Tokens” in the mask that you set up. 

The Mask Tokens are listed in the following table: 

Mask Token Description 

# Retain the right-most, numeric portion of the document number being transferred. 

= Retain the entire document number of the document being transferred. 

Any other characters entered in the mask will be brought over exactly as entered. 

For example, if you are transferring from document number “ABC1234” and your mask is 
“LMNOP#”, the transferred document number will be “LMNOP1234”.  Similarly, if your 
mask is “XYZ-=”, the transferred document number will be “XYZ-ABC1234”.  If your 
mask is “JOE”, which contains no mask tokens, then the transferred document number 
will also be “JOE”. 

DocSync works on three different types of SOP transfers: from Quote to Order, from 
Order to Invoice or from Quote to Invoice.  You don’t have to apply DocSync to each of 
these transfer types, but you do have to specify a mask for each type of transfer that you 
choose to use with DocSync.   
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Payment Approval 

 

Description 

The Payment Approval tool provides auditing and multi-level approval of payments 
processed through Dynamics GP.  Whenever a payment is created, it is tracked and 
routed for approval by up to 3 levels before it can be either posted or printed, depending 
on how the payment is generated. 

The Pmt Approval tab is where you specify all options available for the tool, including 
which types of payments to approve, the payment threshold for each of the three Tiers, 
who the Approvers are and who the Data Entry Users are. 

Approval Options are where you can select which types of payments you want to be 
approved by this process. The options are as follows: 

• Check Payments – force approvals process on Computer Check transactions. 

• EFT Payments – force approvals process on EFT transactions. 

• Single Payments – force payments to go thru the batching and approval 
process by preventing payment information from being entered on an individual 
transaction on the Payables Transaction Entry window. 

Checking the “Require Approver Password” box causes an Approver to be prompted 
for their Dynamics GP password each time they try to Approve, Reject or Clear a 
payment.  These processes will be described in more detail in the Payment Approval 
section later in this document. 
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Checking the “Approve in Tier Order” box forces payments to be approved in Tier order 
from lowest (Tier 1) to highest (Tier 3).  For example, a Tier 2 Approver cannot approve 
a payment that has not yet been approved by a Tier 1 Approver. 

Data Entry users are specified because an Approver needs to notify someone to process 
a batch once it is approved.  By double-clicking a user in the list, you can specify their 
email address.  You can choose to show all users or only the users selected as Data 
Entry Users.  In this way, you can specify email addresses for any user in the system, 
whether they are a Data Entry User or an Approver or neither. 

Approval Tiers 

Up to three levels, or “Tiers”, of approvals are possible for each payment, based on 
monetary thresholds at each level.  A given user can be an Approver for any and all 
Tiers but may only approve a payment at a single Tier. 

To set up an Approval Tier, first check the box for that Tier in the Approval Tiers list.  If 
the current Threshold for this Tier is zero, you will be prompted for the Tier Threshold 
Amount.  Enter a value in this dialog box and click OK.   

If you want every payment to be approved by someone, set the Tier 1 Threshold Amount 
to zero. 

The next step is to add Approvers to this Tier.  As previously stated, any user can be an 
Approver, and a given user can be an Approver at any or all of the Approval Tiers.  To 
add an Approver, first select the Tier to which you want to add an Approver.  Next, click 
the Add Approver button (+) above and to the right of the Approval Tiers list.  This will 
open the Users lookup, where you can select an existing user.  Similarly, to delete an 
Approver, select that approver and click the Delete Approver button.  You will also be 
given the opportunity to delete all Approvers for a given Tier if you choose to inactivate a 
Tier by unmarking its check box. 
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Mentor 
 

 

 
Description 

Mentor allows you to find virtually any window in Dynamics GP by entering a name or 
partial name of the window that you are looking for.  It then returns a list of potential 
matches that you can choose from.  Mentor shows you the navigation and also allows 
you to open that window directly from the results list.  Mentor will also give you a quick, 
easy way to grant or revoke Security access to a window. 

When Mentor is enabled from this tab, you will be able to open it by clicking the toolbar 

icon ( ).  Checking the Default to Opening Mentor on Startup box will cause Mentor to 
open automatically at the log in for each User.  However, individual Users may choose to 
override that setting if they wish by checking the Open at Startup box on the Mentor 
window itself. 

See the Mentor section later in this manual for details of the features of Mentor. 
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Inspector 
 

 

 
Description 

The Inspector tool is designed to give you detailed technical information about the tables 
and fields in any window in Dynamics GP.  This can be extremely helpful when authoring 
reports or creating SmartLists or Extender windows.   

To enable Inspector, simply check the Enable Inspector box on this tab.  Inspector can 
then be opened from the Setup menu, the Shortcut bar or by entering the keyboard 
shortcut (Ctrl+Alt+I). 

See the Inspector section later in this manual for details of the features of Inspector. 
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PopUps 

 

 

 
Description 

PopUps give you a more controlled way to display information to your Users on certain 
windows.  You can create window-specific PopUps that will open whenever the user 
opens that window.  Users can also create their own PopUps, called MyNotes, if you 
want them to have that capability.  Lastly, you can have Dynamics GP record-level notes 
open automatically whenever specified objects (e.g., Customers, Vendors, Items, etc.) 
are used on certain windows. 

System Administrators for the PopUps tool are allowed to create PopUps or MyNotes.  
They are also allowed to reset the dismissed status of any User’s PopUps. 

See the PopUps section later in this manual for more details about the PopUps tool. 
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Widgets 

 

Description 

Widgets are a group of very simple tools that require little to no setup but improve the 
User Experience of Dynamics GP.  The following Widgets are currently available: 

• The Microsoft Dynamics GP Close Confirmation Widget gives the User a 
chance to halt an accidental closing of the entire Dynamics GP application.  

• The Company In Title Bar Widget adds the name of the current Company to the 
title bar of the Dynamics GP main window.  With the company name in the 
Windows Task Bar, running multiple sessions becomes easier to manage. 

• The Task Builder Widget adds a Task Builder option to the Setup Menu for 
Dynamics GP Toolbox.  See the Task Builder Wizard section for more.  

• The Auto Fill System Password Widget allows you to enter the System 
Password only once per Dynamics GP session. The first time you open a window 
that requires the System Password, you will be prompted as usual.  Enter it 
correctly, and every other time you open a window that requires the System 
Password, it will be filled in automatically.  The next time you log into Dynamics 
GP, you will again only need to enter the System Password the first time. 

You can disable any of the Widgets for a given User or Company by adjusting your 
Dynamics GP Security settings.  To do this, remove the Close Confirmation, Company In 
Title Bar and/or Auto Fill System Password Tools from the DEFAULTUSER Security 
Task and then optionally assign them to any other task that suits your needs. 
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Reset Batches 
 

The Reset Batches tool lets you reset “held” batches back to available status. 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Routines >> Dynamics GP Toolbox >> Reset 
Batches. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Routines area, select Reset Batches from the Dynamics GP Toolbox sub menu. 

Description 

The Reset Batches tool resets "held" batches or deletes Batch records.  This replaces a 
very long TechKnowledge (# 7213) with a single click fix.   It does not affect the 
individual transactions, it just allows clearing of activity records and resetting of posting 
flags. 

Using the Tree in the left-hand pane of the window, you can select the type of batches 
you wish to view.  You can select whether to see the hidden or “real time” batches, 
whether to only show marked batches and which series to view.   

Once the desired view is selected, the matching batches are shown in the list in the 
right-hand pane of the window.  Batches can then be selected and either reset back to 
“Available” Status or deleted, using the Reset or Delete Buttons respectively.  Also, 
double-clicking on a batch will open it for editing. 

WARNING! 
Note that this tool only resets the flags on the Batch Header and removes batch activity 
records.  It does not repair damage left by partially posted batches.  It also cannot tell if a 
batch is actually in use, so it should be used with caution. 

Reset Batches will suggest the use of Batch Recovery when appropriate.  Batch Recovery 
can use Microsoft SQL Server’s transaction rollback feature to undo the results of an 
incomplete posting.  
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Period Open/Close 
 
Period Open/Close lets you open or close Fiscal Periods in multiple companies at the same time. 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> Period 
Open/Close. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Period Open/Close from the Dynamics GP Toolbox sub 
menu. 

Description 

Closing periods when you have many Companies can be quite time consuming.  Just 
the time it takes to log into each Company can be significant when multiplied 20 or 30 
times.  The Period Open/Close tool can give you back that lost time (i.e. $$). 

Just select the Fiscal Year for which you want to close periods, then mark the 
Companies in which you want to close them.  Note that you can use the Mark All and 
Unmark all buttons at the upper-right of the Companies list to make this easier. 

On the Dynamics GP Web Client, you can double-click a company to mark it. 

The Fiscal Periods list should now show you the periods for the Fiscal Year you have 
selected.   
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The fiscal calendars for the selected Fiscal Year must be set up the same in each Company 
that you have marked.  This means that they must all have the same first and last fiscal 
day, the same number of periods and each period in that year must have the same period 
date in each Company.  If any of the Companies have a different fiscal calendar setup, you 
will need to close those companies separately. 

Most periods displayed will show as either Open or Closed.  However, you may notice 
that some periods show as Mixed.  This means that in one or more of the years you 
have selected, that period is Open and in the other selected years that period is Closed. 

Opening or Closing a Single Period 

To open or close a period in all of the Companies that you have selected, simply double-
click that period under the appropriate Series column (Financial, Sales, Purchasing, 
etc.).  If the period was Closed it will be opened.  If it was Open or Mixed, it will be 
closed.   

In order to use this tool, a User must have access to the databases associated with the 
Companies selected.  They must also have access to close periods in each of these 
Companies.  Otherwise, access error messages will be displayed. 

Opening or Closing Multiple Periods 

You can select a single period or multiple periods at once using the shift and Ctrl keys, 
like you normally would in any Windows application.  However, instead of double-clicking 
a single period, you will now use the Open or Close buttons to the upper-right of the 
Fiscal Periods list. 

Clicking on either the Open and Close button will show a drop-list of options.  The Open 
button works the same way the Close button does, so for brevity we will just discuss the 
Close button in detail. 

The drop-list on the Close button shows the following options: Fiscal Year, All Series, 
and all six individual periods that are available.  If you choose Fiscal Year, then the all 
periods in all Series in the entire Fiscal Year will be closed, regardless of what you have 
selected.  If you choose All Series, then all Series for only the periods that you have 
selected will be closed. 

If, however, you choose one of the individual Series from the Close button’s drop-list, 
then only that Series will be closed, and only for the periods selected.  If you want to 
close all periods in a series, then select all rows by using Ctrl-A (as you typically would in 
any Windows application), then click the Close button and choose the Series that you 
want to close from the drop-list.  That’s it! 

Generating the Next Fiscal Year 

The Generate button allows you create the fiscal calendar for the next fiscal year for 
each of the companies that you have selected.  The fiscal year that will be created is 
listed in the Next Fiscal Year column of the Companies list at the top of the window.  If 
no Next Fiscal Year is shown, then you will not be allowed to generate for that company. 
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Mentor 
 

The Mentor tool can find virtually any window in Dynamics GP. 

 

You can access this window in one of three ways: 

• Click the Mentor button ( ) on the Dynamics GP toolbar. 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> Mentor. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Mentor from the Mentor sub menu.  

Description 

Dynamics GP and its integrating products provide us with thousands of windows to help 
us do what we need to do.  New users often don’t know where to start; even 
experienced users of Microsoft Dynamics GP sometimes get lost in all the menus. 

Mentor (short for “Menu Locator”) is designed to solve this problem.  It allows you to 
enter a name or partial name of any window that you are looking for.  Then it returns a 
list of potential matches that you can choose from.  Not only does Mentor show you what 
the navigation to a given window is, but it also allows you to open that window directly 
from the results list. 

You will also find that Mentor can assist in creating custom reports, SmartLists and 
Extender windows.  

In addition, for Mentor Administrators, you can also grant or revoke Security access to 
that window without needing to know ahead of time which Security Task or Role it is in.  
Mentor shows you that as well and lets you assign access in a couple of quick, easy 
clicks of the mouse. 

Search  

The Mentor window (shown above) is the main window from which all of Mentor’s 
features are available.  Its main purpose is to allow you to search for, open, and get 
information about windows in Dynamics GP.  Just type in any part of the window name, 

then hit Enter, Tab or the Mentor Search button ( ).  Mentor will then provide you with a 
results window listing all of the windows whose names contain the search value you 
typed.   
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You can type up to ten (10) separate “words”, or parts of words, and Mentor will display 
all of the windows containing any of the words you typed.  For instance, in the example 
above, all windows containing “cust” or “addr” are displayed.  You can further refine your 
results by checking the Match Case check box.   

You can specify that Mentor should only display results that contain a certain word by 
putting a plus sign (+) in front of the word.  For instance, in the example above, if we 
enter +cust addr in the Search for field, then none of the windows from Addresses to 
Company Address Setup will shown up in the results because they do not contain “cust”.   

Similarly, you can specify that Mentor should not display certain words by putting a 
minus sign (-) in front of the word.  So, if type cust addr –company in the Search for 
field, then the three Company Addresses windows would not appear in the results. 

If you want to search for a phrase, or a word that contains spaces, then simply enclose it 
in quotes.  You can also put a plus or minus sign in front of a quoted phrase. 

The results are ranked by the number of matches that are found for each of the words or 
phrases that you enter in the Search for field.  If there is an exact match, it will always be 
listed first, followed by the windows that contain the most matches. 

Clear Search button ( ) 

The Clear Search button clears the Search for field and the results window. 



Rockton Software Dynamics GP Toolbox, 3/19/2024  78 

Options button ( ) 

Clicking the Options button opens the Mentor Options window. 

 

This is where you can control what type of information will show up in the results 
window.  You can also control other things about how the Mentor window behaves. 

The following table describes each of these options: 

Option Description 

Show windows with no navigation Check this box to include windows that cannot be opened 
directly from a menu option.  This would include child windows  

Show windows you can’t access Check this box to include windows for which you have not 
been assigned Security access. 

Show Technical information Show technical information about the windows in the results 
list.  Typically, you would want this unchecked. 

Allow opening windows without 
navigation 

Allows you to open child windows from the Mentor results 
window. 

Opening windows from Mentor 

Most windows can be opened directly from the results list by double-clicking, or by 
selecting a window in the results list and clicking the Open button.  You can only open 
windows for which you have Security access.  Those will be marked with a green check 
mark ( ).  If you do not have Security access, you will see a red stop sign ( ). 

You may notice that some windows are marked with a right-arrow icon ( ).  These are 
“child windows”.  A child window is a window that cannot be opened directly.  Its parent 
window must be opened first; then you can open the child window from its parent.  If you 
try to open a child window from Mentor’s results list, you will be notified that the parent 
window will open instead.  After you click OK on this message, the parent will open. 
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By default, you cannot use Mentor to open windows that cannot otherwise be opened 
directly from a menu option.  The reason that this is not allowed is because some 
windows require that they be opened only in certain ways.  This could be because they 
are child windows, or maybe they are opened automatically in response to some user or 
system action.  Opening these types of windows could have unpredictable results, 
including error messages, window malfunction and possibly nothing happening at all.  

However, if you select the “Allow opening of windows without navigation” option above, 
then you will be allowed to do this, after being given the appropriate warning message.   

Adding Windows to the Shortcut Bar 

Select a window in the results list and click the Shortcut button to add this window to the 
Shortcut Bar.  Note that you will need to restart Dynamics GP in order for it to be visible. 

Export 

The Export button saves the search results to a comma-delimited file. 

Viewing and Changing Security Settings 

Select an item in the Results list and click the Security button to open the Security 
Settings window.  This window is described in detail in the Security Settings window 
section. 

Note that you must have Security access to the Security Settings window in order to use 
this feature.  Otherwise, the Security button on the Mentor window will be disabled. 
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Security Settings window 
 

 

You can get to this window in one of these ways: 

• From the Mentor window, select one of the search results and click the Security button. 

• From the Security Manager window, double-click on the name of an object in the Security 
Objects column. 

• From the Security Manager window, double-click on a security setting that is enclosed in 
curly brackets {} under one of the User columns. 

Description 

The Security Settings window will show you which Security Tasks contain the selected 
window, and which Security Roles are assigned to those Tasks.  The top portion of the 
window shows which product the object is a part of and the object’s Type.  The list at the 
bottom of the window shows the Tasks and Alternate/Modified Forms and Reports IDs 
that contain this object.  You can also expand the Tasks to see which Roles use that 
Task. 

This is useful in determining which Roles or Alternate/Modified Forms and Reports IDs 
you need to grant or revoke access to in order to assign the desired access to a User.  
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You can also select a User and Company to see which Roles and Tasks assigned to this 
User contain this object.  This very powerful feature is not currently available in 
Dynamics GP without Dynamics GP Toolbox. 

If you double-click a Role, Task or Modified/Alternate Forms and Reports ID, the 
corresponding Dynamics GP Security window will open. This will allow you to see details 
about and make changes to the Security Data element that you double-clicked (this, of 
course, assumes that you have Security access to the appropriate Security window). 

Changing Security Settings 

From this window, you can also change Security access for a specified User.  Enter the 
User ID of the User for which you want to change Security access or select it from the 
lookup.  The Company drop-down will now be active.  You will also see that  and  
icons appear to the left of each Role and Modified/Alternate ID.  This indicates whether 
or not the selected User is assigned to that security object for the selected Company.   

 

To change their access, simply click the stop sign or check mark icon.   

 

If you opened this window by double-clicking a security setting on the Security Manager 
window, then the User field will be pre-filled with the User that corresponds to the column 
that you clicked on the Security Manager window.  This makes it easy to see why a User 
has a certain setting for a given security object. 
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If the User that you select is in the POWERUSER Security Role, the words Power User 
will be displayed in blue below the User Name.  If you are granting or removing access 
for a Role and the User selected is a Power User, you will see a message informing you 
that any changes made to individual Roles will not affect what this User has access to.  
This is because a Power User automatically has access to everything in Dynamics GP.  
To activate any individual Roles that you assign to a Power User, you must remove that 
User from the POWERUSER Security Role using the User Security Setup window. 

Each User in Dynamics GP must be assigned to a Modified/Alternate ID.  At the very 
least, they must be assigned to the DEFAULTUSER Mod/Alt ID.  This means that if a 
User is assigned to a Mod/Alt ID other than DEFAULTUSER, and you revoke access to 
this ID, then the system will automatically assign them to the DEFAULTUSER Mod/Alt 
ID.  This also means that you cannot revoke access to DEFAULTUSER if that is the 
Mod/Alt ID to which the User is currently assigned. 

Only Users that have access to the User Security Setup window will be able to 
assign a Role to a User on the Security Settings window.  Users without access to 
the User Security Setup window will be able to view which Roles are assigned to 
a given User, but they will not be able to change them.  In addition, the security 
settings (stop sign or check mark) will be dimmed and the description at the top of 
the window will indicate that they can only view settings, but not change them.  
See below: 
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Inspector 
 
The Inspector window gives you information about other windows in Dynamics GP. 
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You can get to this window in one of these ways: 

• Choose the Inspector item on the Shortcut bar. 

• Type the keyboard shortcut Alt+Ctrl+I 

• Press the F3 key (may not be available if you are already using F3 for another shortcut) 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> Inspector.  

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Inspector from the Dynamics GP Toolbox sub menu. 

Description 

The Inspector tool is designed to give you detailed technical information about the tables 
and fields in virtually any window in Dynamics GP.  This can be extremely helpful when 
authoring reports or creating SmartLists, Extender windows, or other customizations.     

Once you invoke Inspector, the Inspector window opens.  From this point on, until you 
close the Inspector window, any field that you focus your cursor to will populate the 
Inspector window with details about that field and that window.   

Inspector requires that windows be Dexterity-based. 
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A “form” is a collection of windows that are related to each other.  Any given form 
may contain one window or several windows.  Typically, a parent window and all 
of its child windows would be found on one form.  This is not always the case, 
however. 

Table Info mode 

When you first open the Inspector window, the Mode field in the upper-right of the 
window will be set to Table Info.  Window Field Info mode will be discussed in the next 
section. 

Tables are assigned to a form, not to a specific window within a form.  For this reason, 
the tables listed are all of the tables that are used by the current window’s form.   

You will notice that there is a check box to the left of the Display Name column.  If this 
box is checked, it means that the field that you are currently positioned to is contained in 
that table.  To see only the tables that contain that field, simply choose “Tables 
containing this field” from the View drop-down. 

To see the fields in any of the listed tables, double-click that table and the Inspector 
Table Details window will open. 

 

The Export buttons on either of the Inspector windows will create an XML file containing 
the displayed information.  This XML file will be found in the Dynamics GP Data folder 
and it will be named the same as the technical form name or table name, depending 
upon which information you have exported. 
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Window Field Info mode 

When the Mode radio group is set to Window Field Info, you will be able to see all of the 
fields on the window that currently has focus and the values of each of those fields.  This 
includes any work fields or fields that may be hidden from view. 

 

This can be very useful for setting up Smartlists and reports.  For instance, if you need to 
know which numeric value corresponds to the text value that you have selected in a 
drop-down list.  You can see each numeric value easily by simply selecting the different 
items in the drop-down.  As another example, there may be fields that are not shown on 
a window, but you still want to know what those field values are.  For example, the 
values of Batch Status or Marked To Post on a Batch Entry window might be useful 
when troubleshooting posting problems. 

If you are developing any customizations or extensions to an existing window, you may 
need to know a bit about how things work behind the scenes.  If you don’t have source 
code for the window in question, then at least knowing when certain field values change 
may give you enough information to infer what is happening when you take certain 
actions on the window.   

As a convenience, if you are only concerned with a few specific fields, you can select to 
“watch” those fields as they change while you interact with the window.  This is much 
easier than having to scroll through the list of every field on the window, looking for the 
values you want to see.   
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Login Logging 

The Login Logging tool lets you track logins against the Dynamics GP Registered User count.   

 

You can access this window in one of two ways: 

• Go to Inquiry >> Dynamics GP Toolbox >> Login Log. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Inquiry area, select Login Log from the Dynamics GP Toolbox sub menu. 

Description 

The Login Logging tool can be used to track actual logins against your Dynamics GP 
Registered User Count.  This can be useful in determining whether you need to increase 
or decrease the number of Dynamics GP licenses you own.   

Configuration of the Login Logging tool is done via the Log Login tab of the System 
Settings window. 

Login Log Inquiry 

The Login Log Inquiry window (shown above) is where you can view this activity.  When 
you select a login in the top list box, the bottom list will show which Users were already 
logged in at the time that login occurred. 
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User Inactivity Log Inquiry window 
 

The User Inactivity Log Inquiry window shows Users’ inactivity status.   

 

You can access this window by going to Inquiry >> Dynamics GP Toolbox >> User Inactivity Log. 

Description 

The Inactivity Timeout tool is used to log inactive Users out of Dynamics GP gracefully.  
This window shows the current number of inactive minutes for each User currently 
logged in.  In addition, it shows the status of any User that was previously logged in and 
either was logged out due to inactivity or that manually logged out.   

Configuration of the Inactivity Timeout tool is done via the Timeout tab of the System 
Settings window. 

Selecting All Inactive Users for the View drop-down will show the inactivity status of all 
Users that have logged in.  If you choose Only Users with Inactivity then you will only 
see Users listed whose Minutes Inactive is greater than zero. 

You can click the Print button to print a report of the information shown on the window. 
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User Activity Log Inquiry window 
 

The User Activity Log Inquiry window shows activity that has occurred in the system. 

 

You can access this window by going to Inquiry >> Dynamics GP Toolbox >> User Activity Log. 

Description 

The Inactivity Timeout tool is used to log inactive Users out of Dynamics GP gracefully.  
Occasionally, you may find that there are cases where Users are not being logged out 
as you expect them to be.  Using this window to view the activity that has occurred in the 
system can possibly shed light on why they are not being logged out.  

You must first enable logging to the table that stores user activity.  This is done by 
marking the Log Activity check box on the Timeout tab of the System Settings window. 

Use care when using this option because it will likely increase processing time.  Any time 
any activiy happens, including accessing tables, opening windows and running reports, 
among other things, a record will be written to the log table.  Be sure that you uncheck this 
option when you are done troubleshooting. 
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Dynamics GP Toolbox Table Archive/Purge window 

The Dynamics GP Toolbox Table Archive/Purge window is used to purge or archive Login Log 
records. 

 

This window can be opened by going to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics 
GP Toolbox >> Dynamics GP Toolbox Setup.  Then choose the Login Log Maintenance task. 

Description 

The Login Log is contained in the RSTBL01 and RSTBL02 tables, both of which are in 
the DYNAMICS database.  Over time, this log can grow quite large.  The purpose of this 
window is to permanently archive and purge these tables. 

You can see the number of records that are in the selected table, and then define a 
query to select records for purging and/or archiving to XML.  Pressing the Edit Criteria 

button ( ) will open an interactive tool for defining a query to act on the table.  You can 
filter which records you want to archive using this tool.  Once you have done this, you 
will see the number of records that match your query in the ‘Records to be 
archived/purged based on above criteria’ field.  If you need help with this feature, please 
contact Rockton Software or your reseller for support. 

Once you press the Purge button, the selected records will be deleted from the table and 
cannot be recovered without a proper restore. 

We recommend that you first export the records to XML using the Archive button or 

perform a backup to permanently archive the DYNAMICS database before purging a 

table. 
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PopUps 
 

Add required notes, dismissible notes or Tips of the Day to any window in Dynamics GP.  Object 
PopUps allow you to automatically open record-level notes for certain windows in Dynamics GP. 

 

PopUps open automatically when you open a window in Dynamics GP with a PopUp attached. 

Description 

The purpose of this tool is to allow you to create your own notes containing important 
information that you want the user to see at the appropriate time.  There are two 
methods that are used: PopUps and Object PopUps.   

PopUps are used when you want to display general information about a given window in 
Dynamics GP.  This method allows you to define several different types of notes to 
display, and gives you the ability to force the user to see them, let the user dismiss them. 

Object PopUps are used when you want the user to see information about a specific 
entity, or “Object”, on certain windows in Dynamics GP.  Examples of Objects are 
Customer, Vendors, Items, and Employees.  Object PopUps are described in more detail 
later in the section on the PopUp Object Note Setup window. 
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PopUps 

PopUps allow you to create notes that, simply stated, “pop up” when you open 
designated windows in Dynamics GP.  PopUps give you a highly obvious, better 
controlled and more impactful way to display window-specific information to your Users 
than the standard window-level notes in Dynamics GP because: 

• You can create PopUps that are required to be read before the window can be 
closed.   

• You can optionally allow Users to dismiss PopUps once they are read. 

• You can specify effective and expiration dates for PopUps. 

• You can allow your Users to create their own window-specific PopUps, called 
MyNotes. 

• You can create Tips of the Day, which will be shown when no other notes are 
present. 

When PopUps are assigned to a window in Dynamics GP, the Dynamics GP Toolbox 
PopUp window (see the above image) will open automatically when the assigned 
window is opened.  If you move the PopUp window, it will remember its location the next 
time it opens. 

There are three different types of PopUps: 

• PopUp Notes – these are created and maintained by a PopUps Administrator 
(PopUps Administrators are defined on the PopUps tab of the System Settings 
window).  PopUp Notes will have a yellow note background with a yellow or red 
balloon (the red balloon is for High-Priority PopUp Notes, discussed later in this 
section).  They are visible to everyone. 

• MyNotes – these are created and maintained by any User, as well as the 
PopUps Administrators.  MyNotes have a green balloon and note background.  
They are visible only to the User who creates them or to whom they are assigned 
by the PopUps Administrator. 

• Tips of the Day – these are created and maintained by a PopUps Administrator.  
Tips have a blue balloon and note background and are visible to everyone.  
However, they will only be shown if there are no other Notes or MyNotes 
available for a particular window.   

The tabs on the PopUp window will only be enabled if there is a PopUp of that type for 
the assigned window.   

If PopUp Notes exist for a given window, the Notes tab will be selected.  PopUps can be 
assigned a Priority (High, Medium or Low).  When more than one PopUp is assigned to 
a given window, the highest-priority Notes will be displayed first.  If there are no PopUp 
Notes for the window, then the highest-priority MyNotes will be displayed.  If there are no 
MyNotes, then any Tips of the Day that have been created for that window will be 
displayed.  If there are no PopUps defined for that window, then the PopUp window will 
not open. 

A User can view any of the three types of PopUps available for a given window by 

clicking the corresponding tab on the PopUp window. 
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High-Priority PopUps 

If there is more than one PopUp of a given type, the User can scroll through each one 
using the navigation (VCR) buttons in the lower-left.  High-Priority PopUps behave a little 
differently than Medium- or Low-Priority ones. If there are High-Priority Notes for a 
window, the User must read (i.e. scroll through) each one before they will be allowed to 
exit either the PopUp window or the window to which the PopUps are attached. 

Use High-Priority PopUps sparingly!  You may diminish their effectiveness by having 

too many of them.  You also don’t want them to be more annoying than informative. 

If there is only one High-Priority PopUp for a given window, then it will essentially be 

“read” when the PopUp is opened because it will be the first one to be displayed. 

Dismissing PopUps 

When you create a PopUp or a MyNote, you can decide whether or not the User viewing 
that PopUp can dismiss it so it will not be shown to them again.  If a PopUp can be 
dismissed, you will see a check box at the bottom of the PopUp window that will be 
labeled either, “Dismiss this PopUp” or “Dismiss this PopUp until tomorrow”.  The one 
you see is determined by the person who created that PopUp or MyNote. 

If you check “Dismiss this PopUp”, you will only see that PopUp again if you reactivate it 
on the PopUp List window (discussed later in this section).  Checking “Dismiss this 
PopUp until tomorrow” will make this PopUp not show again until the next calendar day. 

Tip of the Day Cycling 

Tips of the Day are a special kind of PopUp.  Like other PopUps, you can scroll back 
and forth to see a window’s other Tips of the Day.  The difference is that Tips will 
automatically “cycle”.  This means that each time you open a window that has Tips 
assigned to it, you will see a different Tip of the Day for that window.  Once you have 
seen all Tips for a particular window, you will start back at the first Tip for that window.   

Compact PopUp 

You can use a smaller version of the PopUp window to maximize screen real estate.  

Click the Switch to Compact PopUp Window button ( ) in the upper-right corner and 
the PopUp will now be smaller: 

 

To switch back, use the Switch to Full PopUp Window button ( ).  Whichever mode you 
choose will be remembered and used the next time a PopUp is opened. 
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PopUp Maintenance window 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> PopUp 
Maintenance. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select PopUp Maintenance from the Dynamics GP Toolbox sub 
menu. 

Description 

All PopUp types can be created using the PopUp Maintenance window.  Typically, this 
window would be used by the Administrator to create PopUp Notes and Tips of the Day.  
Users have a separate window to create MyNotes and that will be discussed later in this 
section. 

The fields on this window will be described in detail in the following section. 
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Creating PopUps 

Follow this procedure to create a PopUp: 

1. Open the PopUp Maintenance window. 

2. Select the PopUp Type.  When you tab off the drop-down, the next available 
PopUp ID will be defaulted automatically.   

3. Enter the name of the window that you want to attach the PopUp to.  You can 
also enter only part of the name, for instance “purch ord proc doc inq”. 

4. Click the Mentor Search button ( ).  Mentor will search for the window that you 
entered.  If it does not display the desired window, try opening the drop-down 
and you will probably find it in the list.  If you don’t find it, try entering a little more 
of the name and click the Mentor Search button again. 

After selecting the desired Window Name, you should see the Product Form and 
Window fill in below the Window Name you just entered. 

5. Select the Priority. This will dictate which PopUps are shown first.   

Remember that High-Priority PopUp Notes are reserved for those Notes that you want to 

require the User to read before they can close the window. 

For Tips of the Day, the only Priority available is Low. 

6. Select the Dismiss option.  This will determine whether the User can dismiss the 
PopUp permanently, until the next day, or not at all. 

7. Enter Effective and Expiration Dates, if desired.  These fields are not required.  If 
not entered, then the PopUp is effective immediately and never expires. 

8. Enter a descriptive Title for the PopUp.  This will show up on the PopUp itself and 
also on the PopUp List window. 

9. Enter the Note.   

10. Click Save. 

You will notice that the Window Name is still the same as the last PopUp you entered.  
This is for convenience, in case you want to add more PopUps for the same window. 

Setting the Initial Open Position 

You can optionally specify the screen position in which PopUps for this window should 
open.  This is useful when attaching a PopUp to special windows called “modal dialogs.”  
A modal dialog is a window that forces you to respond to it before you can continue.  
When a modal dialog is open, you cannot interact with any other Dynamics GP windows 
that may already be open.  In addition, modal dialogs open in the middle of your screen.  
Some examples of modal dialogs are alert messages and the Company Login window. 

Since the PopUp window typically “remembers” the last position in which it was opened, 
there is a possibility that a modal dialog may obscure the PopUp.  Though you can 
always move the modal out of the way, it may be more convenient to simply specify the 
position in which the PopUp should open when attaching it to a modal dialog.  This initial 
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position will only apply to PopUps that are attached to this window.  Any windows that do 
not have an initial open position specified will still open in the last remembered position. 

To set the Initial Open Position, click the expansion button ( ) to the right of the Mentor 

icon ( ).  This will open the PopUp Window Options window: 

 

Here you can enter the Horizontal and Vertical starting position, in pixels, of the PopUp 
window.  Alternatively, you can click the Set button to open the Position PopUp Window 
window: 

 

You can simply move this window around the screen until it is in the desired position.  
Then click the OK button and the Horizontal and Vertical Position values will be filled in 
automatically. 
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Deleting and Copying PopUps 

The Actions button gives you the ability to Delete or Copy the currently displayed 
PopUp.  To Delete an existing PopUp, first select it from the lookup, or scroll to it using 
the VCR buttons.  Then, while the PopUp is displayed, select Delete from the Actions 
button drop-list.  Choose Delete when asked to confirm and the PopUp will be deleted. 

The procedure for copying a PopUp is similar.  First select or scroll to the PopUp you 
want to make a copy of, then choose Copy from the Actions button drop-list.  This will 
open the Copy PopUp dialog.  Select the PopUp Type of the new PopUp and, if you 
select MyNote on this dialog, select the User ID that this MyNote will be assigned to.  
Then click Copy. 

Setting User Access 

You can choose to assign PopUps to specific Users if you so desire.  This is done via 
the Actions button.  Select the PopUp for which you want to set access and choose User 
Access from the Actions button drop-list.  This will open the PopUp Access window: 

 

By default, the All Users check box is marked.  If you unmark this box, then you can 
mark or unmark individual Users in the list.  You can also use the Mark All and Unmark 
All buttons to make this easier. 

If All Users is not marked, new Users added to Dynamics GP will not be able to see this 

PopUp unless you mark those new Users manually in the PopUp Access window.  

If you do mark All Users, then any new Users added to Dynamics GP will automatically 

be able to see this note. 

When you are done click OK.  User Access is now assigned. 
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MyNote Maintenance window 

 

You can access this window in one of three ways: 

• From virtually any window in Dynamics GP, go to Additional >> Enter MyNotes. 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> MyNote 
Maintenance. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select MyNote Maintenance from the Dynamics GP Toolbox sub 
menu. 

Description 

The MyNote Maintenance window is used specifically by Users to create their own 
PopUps.  These User-created PopUps are called MyNotes.  The fields on this window 
will be described in detail in the following section. 
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Creating MyNotes 

Follow this procedure to create a MyNote: 

1. Open the MyNote Maintenance window.  If you opened this window from the 
Additional menu of some other window, then you can skip to step 4. 

2. Enter the name of the window that you want to attach the MyNote to.  You can 
also enter only part of the name, for instance “purch ord proc doc inq”. 

3. Click the Mentor Search button ( ).  Mentor will search for the window that you 
entered.  If it does not display the desired window, try opening the drop-down 
and you will probably find it in the list.  If you don’t find it, try entering a little more 
of the name and click the Mentor Search button again. 

4. Select the Priority. This will dictate which MyNotes are shown first.   

5. Select the Dismiss option.  This will determine whether the User can dismiss the 
MyNote permanently, until the next day, or not at all. 

6. Enter the Effective and Expiration Dates, if desired.  These fields are not 
required.  If they are not entered, then the MyNote is effective immediately and it 
never expires. 

7. Enter a descriptive Title for the MyNote.  This will show up on the PopUp itself 
and also on the PopUp List window. 

8. Enter the Note.   

9. Click Save. 

You will notice that the Window Name is still the same as the last MyNote you entered.  
This is for convenience, in case you want to add more MyNotes for the same window. 

You can optionally specify the screen position in which MyNotes for this window should 
open.  This procedure is described in the Setting the Initial Open Position section, 
above. 
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PopUp List window 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> PopUp 
List. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select PopUp List from the Dynamics GP Toolbox sub menu. 

Description 

The PopUp List window is used to view PopUps and activate dismissed PopUps.  If you 
are a PopUps Administrator, this window will open in Administrator View and you will be 
able to view and activate PopUps assigned to any User.  If not, then the window will 
open in User View and you will only be able to view and activate your own PopUps. 

Filters 

In Administrator View, you can enter or select a User for which to view PopUps.  In User 
View, the User field will be set to your User ID and it will be locked, along with its lookup. 

You can select the PopUp Type to view, or select All PopUp Types. 

The Show drop-down will allow you to view Read PopUps, Unread PopUps, or All 
PopUps.  When showing Read PopUps (or All PopUps, which includes read ones), you 
will also be able to specify whether you want to view Active PopUps, Dismissed PopUps 
or both.   

Once you have made your Filter selections, click the Redisplay button. 
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The PopUp List 

You can double-click any PopUp in the list to view details about that PopUp.  If you are 
in Administrator View, the PopUp Maintenance window will open with the selected 
PopUp displayed.   

If you are in User View, then what happens when you double-click a PopUp depends 
upon the PopUp Type.  If the PopUp Type is MyNote, then the MyNote Maintenance 
window will open with the selected PopUp displayed.  If it is any other type of note, then 
the PopUp List Display window will open to show you the details of that PopUp. 

 

Activating Dismissed PopUps 

In User View, you can only Activate your own dismissed PopUps.  Therefore the Activate 
button has just this one function.  Select one or more dismissed PopUps in the list and 
click the Activate button to activate these PopUps for you only. 

However, in Administrator View, the Activate button has a drop-list with two options: For 
the displayed User and For All Users.  If you choose For the displayed User then the 
PopUps that you have selected will be activated only for the User that you have selected 
in the Filters area of the window.  If you choose For All Users then the selected PopUps 
will be activated for all Users to which they are assigned. 
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PopUp Object Note Setup window 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> PopUp 
Object Note Setup. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select PopUp Object Note Setup from the Dynamics GP Toolbox 
sub menu. 

Description 

Object PopUps are Dynamics GP record-level notes that open automatically when a 
certain entity, or “Object”, is used or displayed on certain windows.  This can be very 
useful when you want your users to know something about a particular Item or 
Customer, etc., before it is used. 

Unlike PopUps, Object PopUps use the note information that you have already entered 
in Dynamics GP by clicking the standard Note icon that can be found on most windows 
in Dynamics GP.  The following image illustrates the Customer Note icon on the Sales 
Transaction Entry window: 
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You will use the PopUp Object Note Setup window to specify that you want a note to be 
displayed on a given window.  This will cause the standard Note window to open 
whenever that window shows that object, or whenever you select or enter that object on 
that window, just as though you had clicked the Note icon yourself. 

There are several Objects that can be used with Object PopUps.  For each of these 
Objects, there are certain windows where Object PopUp functionality is available.  These 
are listed in the following table: 

Object Name Windows where Object PopUps will open for this Object 

Accounts Account Maintenance 
Fixed Allocation Maintenance 
Unit Account Maintenance 
Variable Allocation Maintenance 

Checkbooks Checkbook Maintenance 
Bank Deposit Entry 
Miscellaneous Check 
Reconcile Bank Statements 
Bank Transaction Entry 
Bank Transfer Entry 

Customers Customer Maintenance 
Sales Transaction Entry 

Employees Employee Maintenance 

Items Item Maintenance  
Purchase Order Entry 
Receivings Transaction Entry 
Sales Transaction Entry 

Vendors Vendor Maintenance 
Purchasing Invoice Entry 
Purchase Order Entry 
Receivings Transaction Entry 
Returns Transaction Entry 

Creating Object PopUps 

To add new Object PopUps, first select the Object Name at the top of the window, then 
click the Add Object PopUps button ( ) to open the Add PopUp Object Note Setups 
window: 
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Here you will see a list of all of the windows where Object PopUps are available for this 

Object.  You can use the Lookup button ( ) to select the instance of the Object for 
which you want to add Object PopUps, or you can just type the ID of that Object as the 
Field Value.  For instance, in the image above we are showing Object PopUps for the 
“FIRST BANK” Checkbook Object.  You can see here that we want the record-level note 
to open on some of the available windows, but not on others, and only when the 
Checkbook ID is equal to “FIRST BANK”.  Once you have selected the windows where 
you want Object PopUps to work for this Field Value, click the Add button.  You will now 
see these items listed in the PopUp Object Note Setup window.   

If you want to define additional Object PopUps for the same Object, but different Field 
Values, then simply click the Add Object PopUps button again and select a new Field 
Value, then repeat the process described above.   

In addition, if you want Object PopUps to open for ALL values of the selected Object, 
leave the Field Value blank.  These will then show in the PopUp Object Note Setup 
window with a “Yes” in the “All Checkbooks” (or “All Items”, etc.) column.  In the above 
example. this would indicate that you want the note window to open any time that a 
Checkbook ID that has note attached to it is displayed or used on any of the selected 
windows. 

Modifying Object PopUps 

To make a change to an existing Object PopUps, select an Active PopUp from the list on 
the PopUp Object Note Setup window, then click the Edit Object PopUps button ( ) to 
open the Modify PopUp Object Note Setups window: 
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Here, you can type a new Field Value or select a new one from the lookup.  Click the OK 
button and the Field Value will be updated for that Object PopUp. 
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Reason for Hold 
 

 

If you have enabled the Reason for Hold tool and have selected Enable for Customers, this 
window will open automatically when you place a Customer on Hold on the Customer 
Maintenance window.   

Description 

The Reason for Hold tool will force the User to enter a reason for placing a Customer or 
Vendor on hold.  In addition, when a Customer or Vendor on hold is displayed or entered 
on certain transaction and inquiry windows, the reason entered will be displayed.   

When this tool is enabled (and the Enable for Customers option is chosen), any User 
that has access to the Customer Maintenance window will be presented with the above 
window when they mark the Hold check box.  They will then need to enter a reason for 
the hold and click Save, which will close this window and allow them to save the 
Customer record.  If they click Cancel, then the Hold check box will be unmarked. 

Similarly, the Enter Reason for Vendor Hold window will open when marking the Hold 
check box on the Vendor Maintenance window if the Enable for Vendors option is 
chosen. 

Once you have placed a Customer or Vendor on hold, the next time you display a record 
that Uses that Customer or Vendor on certain windows, the previously entered reason 
will be displayed as in the following example: 



Rockton Software Dynamics GP Toolbox, 3/19/2024  107 

 

The windows where this functionality exists are as follows: 

For Customers 

• Customer Maintenance 

• Customer Inquiry 

• Sales Transaction Entry 

• Enter Drop Ship Customer (via the Purchase Order Entry window) 

For Vendors 

• Vendor Maintenance 

• Vendor Inquiry 

• Receivings Transaction Entry 

• Payables Transaction Entry 

• Purchase Order Entry 

You will notice that this window is similar to the one that you saw when you originally 
placed the Vendor on hold.  However, on this window you will see a check box at the 
bottom that is labeled, “Don’t show me this message again for this Vendor.”  If you check 
this box, then any time this same Vendor is displayed on any of the windows listed 
above the Reason for Vendor Hold window will not automatically open.  This will 
remain in effect for the remainder of the time that you are logged into Dynamics GP.  
Note that you can always choose “Reason for Hold” from the Additional menu and you 
will still see be able to see this window if you want to. 
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Payment Approval 

 

If you have enabled the Payment Approval tool, this window will open when choosing Additional > 
Payment Approval from any of these Purchasing windows: 

• Payables Batch Entry 

• Print Payables Checks 

• Select Payables Checks 

• Payables Manual Payment Entry* 

• Payables Payments Zoom 

You can also open this window by going to Microsoft Dynamics GP > Tools > Setup > Dynamics 
GP Toolbox > Payment Approval. 

* - Note that approval of Manual Payments is not available at this time.  When opening this 
window from the Payables Manual Payments Entry window, you can still use it to approve other 
payment types, but not manual payments. 

Description 

The Payment Approval window is used for tracking and viewing the payment approval 
process.  You can approve or reject payments, if you are an Approver, and you can view 
the approval status of payments in a given Batch if you are a Data Entry (i.e. non-
Approver) user.  This window is also used to notify Approvers that a Batch is ready to be 
approved, and to notify Data Entry Users that an approved Batch is ready to be posted. 

When payments are created, you are prevented from processing them individually (i.e., 
they must be batched).  Therefore, on-the-fly posting or payment entry will be disabled.  
When a payment is edited, its approval status is reset and must be re-routed for 
approval again. 
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Only batches with a payment method (i.e. Checks or EFT) that has been selected on the 
System Settings window will be shown on this window.  Also, if a batch has been 
printed, but not posted, you will not be able to process that batch on this window. 

The interactive grid can be sorted by column, and the selected sort order will be 
remembered as long as you are in the Payment Approval window.  Double-clicking on a 
line in the list will zoom to the appropriate windows, based upon which column your 
cursor was in when you double-clicked.  The following table lists the window that you will 
be zoomed to when you double-click on the given column: 

Column Zooms to Window 

Status Payment Approval Audit Inquiry 

Approver 1, 2, or 3 Payment Approval Audit Inquiry 

Payment The transaction window that corresponds to the selected payment type 

Invoices Payment Detail Inquiry 

Amount Payment Detail Inquiry 

Vendor ID or Vendor Name Vendor Maintenance 

Comment Payment Approval Audit Inquiry 

You can use the filter check boxes at the top of the window to show only certain statuses 
in the Payment Approval window.  This can be useful if you only want to see which 
payments still need to be approved for the displayed Batch. 

The Approval Process 

Approval processing is done at the Payment level.  Each payment, regardless of the 
number of invoices on it, is tracked for approval.  A batch can only be processed when 
every transaction is approved by the rules in place.  If a single transaction is 
unapproved, it can be moved to its own batch to allow the remaining batch of 
transactions to process. 

If a user can approve at two different levels, such as Level 1 and Level 2, they cannot 
approve both levels for a given payment.  They can choose either level to approve, but 
not both. 

In a given batch, any combination of users can approve a level.  The same user does 
not have to be consistent for the entire batch.  Multi-level approvals do NOT have to be 
approved in order.  That is, Level 3 can be approved before Level 1.  However, if you 
wish to have Tier 1 approve before Tiers 2 or 3, use the setup option Approve in Tier 
Order on the Pmt Approval tab of the System Settings window. 

When a Payment is modified, or moved to a different Batch, its approval status is reset. 

After a Data Entry user has completed work in the Payment Approval window, they can 
notify, by email, the appropriate users for the next stage or stages of approval.  For 
instance, if a Tier 1 Approver has approved all of their transactions in this batch, they 
can notify the Tier 2 Approvers that it's their turn to approve.  By clicking the Notify 
button, the user can choose to see a list of Tier 2 users, and can choose all or just 
selected users to notify.  Similarly, an Approver can notify the Data Entry Users that the 
Batch has been fully approved and that they must now Post the Batch.  Email 
notifications will contain a simple message containing the Batch ID and which action is 
requested.   
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The Payment Approval Audit Log 

Each payment will have a running audit log.  Automatic audits will occur when: 

• A payment is created. 

• A payment is deleted. 

• A payment is modified. 

• A payment is moved to another Batch. 

• A payment is approved at any level. 

• A payment is rejected. 

• A payment approval is cleared. 

• A payment rejection is cleared. 

To view the Audits for a given payment, double-click the Status, Approver or Comment 
column for any payment listed.  This will open the Payment Approval Audit Inquiry 
window for this payment.  Any user can also add a comment to the payment on this 
window.  Adding or changing the Comment field will also add an audit for this payment, 
as can be seen on the first line in the screen below. 
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Payment Detail Inquiry 

The Payment Detail Inquiry window shows the individual transactions that make up a 
given payment.  You can get to this window by double-clicking the Invoices or Amount 
column for a payment in the Payment Approval window. 

 

You can zoom to the appropriate inquiry window by double-clicking a line in the Payment 
Detail Inquiry window. 
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Batch Review 
 

 

To open this window, go to Microsoft Dynamics GP > Tools > Setup > Dynamics GP Toolbox > 
Batch Review.   

Description 

Switching between multiple batches, moving transactions into new batches, reviewing 

who approved batches, and going to multiple locations just to review, edit, and post 

batches can all be very time intensive activities.  We created the Batch Review window 

so that you can do all of these things from one central location.  You can perform the 

most common batch functions for any General Ledger, Inventory, Payables 

Management, Purchase Order Processing, Receivables Management, and Sales Order 

Processing Batches. 

Another drawback of the way transaction windows typically work in Dynamics GP is that 

they are not bound by the Batch that you are intending to work in.  Let’s say you first 

select batch on a transaction window, then select the first transaction from the lookup.  

When you are done with that transaction, you might be tempted to click the Next 

navigation button (VCR button) to scroll to the next transaction in that batch.  Unless you 

are carefully checking the Batch Number field on each transaction, you may miss the 

fact that Dynamics GP has scrolled to a transaction in another batch entirely!  The Batch 

Review window solves this problem by only listing the transactions for the selected 

Batch Number. 
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Working with Batches 

There are a few ways to work with this window, depending upon what you are trying to 
accomplish.  The Batch Review window is geared towards working with one batch at a 
time, so the first thing is to select a Batch.  You can do this either by using the Batch ID 
lookup button or by scrolling with the navigation buttons (VCR buttons) on the bottom-left 
of the window.   

One thing to note about this is that the option you have selected in the Series Filter will 
affect both the lookup and the navigation buttons.  So, for instance, if you are only 
interested in working with Financial batches, then select Financial in the Series Filter and 
the lookup will only list General Entry, Clearing Entry, and Budget Transaction batches.  
Similarly, the navigation buttons will only scroll through batches of those types. 

Once you have selected a Batch to work with, you will see that the Batch Total and 
Number of Trx are both displayed, as well as the Marked to Post flag and Approval 
information.  This information is display only, however you can always click on the Batch 
ID hyperlink to zoom to the entry window for that batch type.  You should be able to 
make whatever batch changes you need to on that window. 

Batch-level functions 

These functions are accessed via the buttons in the ribbon at the top of the window. 

Delete Batch 

The Delete button will allow you to delete batches of any type.  You will notice that this 
will simply open the Batch entry window for that type of batch, and then basically just 
click the Delete button.  This is done to ensure data integrity.  Any necessary batch 
locking and validation will be handled by the coding that is already present on that 
window.  

Post Batch 

The Post button will allow you to post batches of any type except for Computer Checks.  
You will notice that this will simply open the Batch entry window for that type of batch, 
and then basically just click the Post button.  This is done to ensure data integrity.  Any 
necessary batch locking and validation will be handled by the coding that is already 
present on that window. 

Batch Approval 

The Approve and Unapprove buttons will allow you to either approve or remove approval 
on any batches that have batch approval enabled.  The Approval Status fields on the 
Batch Review window will be updated accordingly. 
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Transaction-level functions 

These functions are accessed via the buttons located to the upper-right of the list area of 
the window.  Once you have performed one of these functions, the Batch Total and 
Number of Trx fields on the Batch Review window will be updated accordingly. 

Add Transaction(s) 

The Add Transaction(s) button ( ) will open the appropriate transaction entry window, 
ready for you to enter a new transaction into the currently displayed Batch.   

Edit Transaction 

You can edit a transaction by first selecting that transaction in the list and then clicking 
the Edit Transaction button ( ).  This will open the appropriate transaction entry window 
with the selected transaction displayed.  You can also edit a transaction by simply 
double-clicking that transaction in the list. 

 You must select exactly one transaction in the list first. 

Delete Transaction(s) 

You can delete one or more transactions by first selecting any number of transactions in 

the list and then clicking the Delete Transaction(s) button ( ).  You will be prompted to 
confirm your desire to delete the selected transactions.  If you choose Yes, the 
appropriate transaction entry window will open, displaying and deleting each transaction 
that you had previously selected.  This is done to ensure data integrity.  Any necessary 
locking and validation will be handled by the coding that is already present on that 
window. 

For Payables Transactions and Payables Manual Payments, you must select 
exactly one transaction in the list first.  For other types of transactions, you may 
select as many as transactions as you wish before clicking the Delete 
Transaction(s) button. 

Void Transaction(s) 

You can void one or more transactions by first selecting any number of transactions in 

the list and then clicking the Void Transaction(s) button ( ).  You will be prompted to 
confirm your desire to void the selected transactions.  If you choose Yes, the appropriate 
transaction entry window will open, displaying and voiding each transaction that you had 
previously selected.  This is done to ensure data integrity.  Any necessary locking and 
validation will be handled by the coding that is already present on that window. 

You can only void transactions of the following types: 

Financial Transaction Entry 
  Financial Clearing Entry 
  Sales Transaction Entry 
  Purchase Order Entry 
  Receivings Transaction Entry 
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Transfer Transaction 

You can transfer a transaction by first selecting that transaction in the list and then 

clicking the Transfer Transaction button ( ).  You will be presented with the same Sales 
Transfer Documents window that you would be if you transferred that document from the 
Sales Transaction Entry window.  This is done to ensure data integrity.  Any necessary 
locking and validation will be handled by the coding that is already present on that 
window. 

You must select exactly one transaction in the list first. 

You can only transfer Sales transactions. 

Move Transaction(s) to Another Batch 

A feature not available in Dynamics GP is the ability to select multiple transactions and 
move them from one batch to another. You can accomplish this on the Batch Review 

window by clicking the Move Transaction(s) to Another Batch button ( ).  You will be 
presented with the Move Transaction(s) to Another Batch window: 

 

Use the lookup button ( ) to select a Batch Number to which to transfer these 
transactions, then click the Move button. 

You must select one or more transactions in the list first. 

The To Batch Number that you select must be the same type as the From Batch 
Number, therefore the Batches lookup window will only show Batches that are of 
the same type as the To Batch Number. 

Reset Button 

Clicking the Reset button in the ribbon will open a drop-menu that lists one option: Reset 
Batches.  This is simply another way to get to the Reset Batches window in Dynamics 
GP Toolbox and is provided simply for convenience.  
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Security Manager 
 

 

To open this window go to Microsoft Dynamics GP > Tools > Setup > Dynamics GP Toolbox > 
Security Manager.   

Description 

The Security Manager is a simple interface for viewing, reporting, and managing 
security.  The left of the window shows the security items (i.e., Roles, Tasks, 
Alternate/Modified Forms and Reports IDs and Security Operations, such as Windows, 
Reports, Tables, etc.) in a tree.  This provides much improved navigation over the 
standard security windows in Dynamics GP.  The right side, called the “security grid”, 
shows a list of all security settings.  Using this window, you can quickly see which users 
have access to the resources in Dynamics GP.  

You also have the ability to modify the displayed security settings by double-clicking the 
cells in the security grid.  Since Security Manager gives you the ability to perform many 
security changes at once, only one User at a time will be allowed open this window. This 
will prevent one User’s set of changes from conflicting with another User’s changes. 

If you have Rockton’s Auditor product installed, and Segregation of Duties 
Groups have been set up, you can choose to show any Segregation of Duties 
conflicts in the Security Manager window.  Any mention of Segregation of Duties 
conflicts in this document only applies if you have Auditor installed and have set up 
Segregation of Duties Groups. 



Rockton Software Dynamics GP Toolbox, 3/19/2024  117 

Only one company’s security can be managed at one time.  Choose the desired 
company from the drop-down list at the top of the window.  Next, choose a Filter.  Filters, 
discussed in more detail below, tell Security Manager which objects to display. 

For Filters that contain Roles, you can choose the level of detail that you want to see 
from the View drop-down at the upper, far right.  You can choose to list only the Roles, 
or you can choose to see the Roles and the Tasks within each Role (organized by 
Category), or you can choose to see the Roles, the Tasks that make up each Role, and 
the Details (Security Operations) that make up those Tasks.   

When viewing the z.ALT-MOD IDS default Filter, you can choose whether you want to 
see all Alternate and Modified versions of the objects listed, or only the Alternate 
versions or only the Modified versions. 

By clicking the Select Users button  you can select whether to view all users or just 
selected ones.  By selecting specific users, you can wade through the clutter of viewing 
all of them at once.  However, only Users that have access to the selected Company will 
be shown, regardless of which ones are chosen in the Select Users window.   

Security Grid 

 

The right side of the Security Manager window is called the security grid.  The first 
column of the security grid will generally contain the name of the security item being 
displayed.  An asterisk (*) at the end of a name indicates that there are Alternate or 
Modified versions of this item available.  However, you can also optionally choose to 
show an Index Column (see the Security Manager tab on the System Settings window), 
which is simply a numeric value indicating each object’s position in the list.  In this case, 
the Index Column will be the first column and the security item name is the second.  

Each additional column shows the security settings for that security item for that 
column’s User.  The security settings you will see are described below: 

Setting Description 

Yes Standard security access is granted to the User for this item.  If Alternate or Modified versions of the 
object are available, the User does NOT have access to any of them. 

# Yes The same as Yes, except that this User has a Segregation of Duties Conflict for this item. 

Yes* Access is granted to the User for an Alternate or Modified version of this item.  

# Yes* The same as Yes* except that the User has a Segregation of Duties Conflict for this item. 

No No security access is granted to the User for this item.  Note: If you are viewing an Alternate or Modified 
object, the User may still have access to the base version of that object. 

If the security settings described above are enclosed in curly brackets (e.g. { # Yes* } ), 
this indicates that you cannot directly change the value of this particular cell.  This could 
happen for one of the following reasons: 
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• The cell is for an item at the Security Operation-level (security may only be 
assigned at the Role-level). 

• Your user does not have the authority to change security access.   

Only users that have Security access to the User Security Setup window will have 

update privileges to change access settings on the Security Manager window or 

anywhere else within Dynamics GP Toolbox.  

Double-clicking in the security grid 
Double-clicking in the security grid gives you access to several useful functions, 
depending upon the column and the type of object you are double-clicking. 

Security Item Name column 
If you double-click a line that contains a Role ID, then the Security Role Setup window 
opens for that Role.  Similarly, if you are on a Task ID or Alternate/Modified Forms and 
Reports ID, then the corresponding setup window will open. 

For Security Operations (e.g., Forms, Reports, etc.) double-clicking in the name column 
will open the Security Settings window. 

Double-clicking on Folder line will do nothing. 

User column 
If you are on a line that contains a Role ID, then double-clicking a User column’s security 
setting will behave according to the settings you have chosen on the Security Manager 
tab on the System Settings window.  This will allow you to double-click a security setting 
to change its value (if you have security update privileges), or you can see details for 
that security operation and setting (see the Security Detail Zoom window section, later in 
this document).  This is also where you can zoom to details about any Segregation of 
Duties Conflicts that may exist. 

For lines that are for a security operation, double-clicking on a security setting cell will 
give you the option to open the Security Settings window with that User prefilled.  If you 
have security update privileges, you will be able to make your security assignment on 
that window.  This is also a good way to investigate a security object’s value.  For 
instance, if a Form shows { Yes } but the User does not have access to the Role that 
contains that Form, you can use the Security Settings window to see other Roles the 
User has access to that also allow them to open this form.  Even if you do not have 
update privileges, you will still be able to view this information. 

Double-clicking on a line that shows no security setting will do nothing. 

Using the context menu (right-click) in the security grid 
You can change the security settings for a User for several Roles at a time by first 
selecting the group of rows that you want to change, then right-clicking anywhere in the 
column for that User.  Click on either Yes or No on the context menu pop-up and all 
selected objects for that User will be changed to that value.  It is recommended that you 
change your View Option to Roles Only, to make it easier to select multiple Roles.  In 
addition, you can change Security settings for the entire column by first clicking Ctrl-A to 
select all rows, then right-clicking in the column for the User that you wish to change. 
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Display Optimization 
Choosing Roles, Tasks and Details in the View drop-down is a great way to see exactly 
which Security Operations a User has access to.  While it is useful to see all details of a 
Role, keep in mind that the large amount of data being calculated could cause the 
display of the window to take a while.  This is especially true when you are trying to 
display a large number of Roles, such as is the case with the z.ROLES default Filter. 

For this reason, the Security Manager tool has a feature called Display Optimization, 
which can help speed up the display of large Filters, especially those containing Roles.  
With Display Optimization, certain Security tables are copied (or “cached”) to memory, 
causing their access to be much faster than if they were accessed directly.  The trade-off 
is that more memory (RAM) is used; therefore there is less of it available for Dynamics 
GP to use for other processes which the Security Manager window is displaying. 

Display Optimization can be started and stopped in two ways: 1) by clicking the Display 
Optimization button on the upper-right of the Security Manager window (see details 
below), or 2) from the Security Mgr tab on the System Settings window.   

Easy Access to Dynamics GP Security Windows 
The Security Manager window is a central starting point for most Security administration 
in Dynamics GP.  As already discussed above, you can access the Security Role Setup, 
Security Task Setup and Alternate/Modified Forms and Reports windows by double-
clicking on the name of a Role ID, Task ID or Alternate/Modified Forms and Reports ID 
in the security grid.   

The Dynamics GP User Security Setup window is no longer necessary because you can 
now assign all User security, including the assignment of Alternate/Modified Forms and 
Reports ID, via the security grid on the Security Manager window.   

User Setup and User Access Setup windows are available from the Users button.  In 
addition, you can open the User Copy window, which gives you the ability to copy 
access from one user to another, even across companies. 

Controls on the Security Manager window 

OK button 

The OK button closes the Security Manager window. 

Users button   

This button allows easy access to User Setup, User Access Setup and User Copy 
windows.  See below for details of the User Copy window. 

Import and Export buttons   

The Export button is a button drop-list with two options: Excel (formatted) and CSV 
(unformatted).  The Excel option uses the displayed list to create a new Excel 
worksheet, with some formatting such as bolded folder names.  The CSV option creates 
a comma-delimited text file with the same information, but no formatting.  You may want 
to use the quicker CSV option if the Excel file takes a long time to create.  The Import 
button will take a file that is in the Export file format and use it to update security settings 
en masse. 
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Redisplay button  

Refresh the current display. 

Print button  

Pressing the Print Button gives a print dialog with output options for the Security 
Settings (current view) report.  This is a quick list of what you see on the Security 
Manager window 

Company drop-down   

Selects the Company for which you wish to view Security settings. 

Filter ID 

The Filter ID selects the Filter (i.e., list of security items) that you want to display.  You 
can select an existing Filter by clicking the Lookup icon and selecting one from the list, 
or by simply typing its name in the Filter ID field.  To create a new Filter, type a Filter ID 
that doesn’t already exist and hit the Tab key.  You will then be asked if you want to 
create a new one.  If you respond “Yes”, then the Filter Maintenance window (discussed 
later) will open so you can add the new Filter. 

These default Filters are created automatically when you install Dynamics GP Toolbox: 

Filter Description 

z.ALT-MOD IDS Lists Alternate/Modified Forms and Reports IDs and their operations. 

z.POSTING Lists all Posting Permissions for Microsoft Dynamics. 

z.REPORTS Lists Reports for Microsoft Dynamics and all installed integrating products. 

z.ROLES Lists all Roles for Microsoft Dynamics and all installed integrating products. 

z.SMARTLISTS Lists all Smartlists for Microsoft Dynamics and all installed integrating products. 

z.WINDOWS Lists all Windows for Microsoft Dynamics and all installed integrating products, 
whether or not they can be opened from a standard GP menu. 

Display Optimization button    

The color of this button tells you the state of Display Optimization.  Green indicates 
display is optimized.  Yellow indicates that the Display Optimization cache is currently 
being built.  Gray indicates that the cache is empty and display is not optimized.   

You can also click this button to change the state of Display Optimization.  If the button 
is green when you click it, you will be asked if you want to clear the Display Optimization 
cache.  If it is gray, you will be asked if you want to start Display Optimization.  If it is 
yellow, you will simply see a message informing you that Display Optimization is 
currently in progress. 

View drop-down    

When displaying the z.ALT-MOD IDS default Filter, the View drop-down lets you see all 
Alternate and Modified versions, Alternate versions only or Modified versions only. 

For Filters that contain Roles, the View drop-down selects the level of Role detail that 
you want to see.  You can choose “Roles Only”, “Roles and Tasks” or “Roles, Tasks and 
Details”.  Selecting the latter option will list all Security Operations that are selected for 
each Task and each Role that is displayed. 

For any other Filters, the View drop-down will be disabled. 
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Select Users button  

Click this button to choose which Users to display in the security grid.  It will open the 
Select Users window.   

 

You can mark or unmark users individually by clicking their check boxes, or you can 

select or deselect all users by using the Mark All or Unmark All buttons . 

Checking the All Users box will display all Users on the Security Manager window.  
However, any individual selections that you made previously will still be saved.  This 
enables you to uncheck All Users and all of your previous selections will still be checked. 

Search bar    

The Search bar allows you to search the objects listed.  Click the Search button  after 
entering a search value.  If the value entered is found in the list, then the list will be 
scrolled so that the object containing that value will be displayed.  If you repeatedly click 
the Search button, then the next object containing the entered value will be displayed. 

If you check the Match Case box, then the value entered must match exactly, including 
upper- or lower-case characters.  If you do not check this box, then case will be ignored. 

Legend button 

The Legend button opens the Legend window 
which lists all of the icons used in Security 
Manager and their meanings.  Click the Legend 
button again to close the Legend window. 
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Security Detail Zoom window 

 

The Security Detail Zoom window is used to display details about a specific security 
setting.  You can also click the Change button at the top of the window to change its 
security settings.  However, if the Setting is surrounded by curly brackets, then changing 
this setting is not allowed and the Change button will be disabled.   

In order to get this window to open when you double-click a cell in the security grid on 
the Security Manager window, you must have Toggles Security if simple, zooms if 
options or Zooms to detailed security settings selected on the Security Manager tab of 
the System Settings window. 

The Security button will open the Security Settings window with the User ID and 
Company pre-selected from the values on the Security Manager window.  This allows 
you to see the Roles and Tasks which are assigned to this User that are responsible for 
them having access to this window.   

If there is a Segregation of Duties conflict for this resource, the View Conflicts button will 
be enabled.  If you click this button, the Segregation of Duties Conflicts window will open 
and show you the details of the conflicts. 

Any modified or alternate versions will display in the list at the bottom of the window. 
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Segregation of Duties Conflicts window 

 

This window is where you can see details of a Segregation of Duties Conflict for a given 
User.   You will see the window that caused the conflict, as well as the details of the rule 
(Segregation of Duties Group and Exclusion ID) that resulted in the conflict.   

You will only see this window if you have Rockton’s Auditor product installed, 
and Segregation of Duties Groups have been set up in that product. 
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User Copy window 

 

The User Copy window allows you to copy Security settings from one User to several 
others, even across companies.  You open this window by clicking the Users button on 
the Security Manager window and choosing User Copy from the drop list. 

You can copy Security settings from one User/Company to any other User or Users in 
any Company or Companies.  The only exceptions are: 

1. You cannot copy access from a User to itself in the same Company. 

2. You cannot copy access from LESSONUSER1 or LESSONUSER2 to a 
Company other than the Lesson Company (Fabrikam, Inc.).   

First, select the User from which you want to copy access.  The From Company list 
should then populate with the Companies to which this User has access.  Select one of 
these Companies from which to copy the selected User’s access.   

Next, select any number of Users and Companies to which you want to copy access.  
Click the Next button and the User Copy Confirmation window will open listing the 
actions that will take place: 
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If any of your selections result in a case where the copy would not be allowed (see the 
two exceptions listed above), then you will be notified of this on the confirmation window.   

If you are satisfied with the actions that will be taken, click the Copy button to perform 
the copy.  Otherwise, click Cancel. 

Copying access to a new user 

You may also wish to create a brand new user and then copy access from an existing 
user to that new user.  To do this, first click the Create User button.  This will open the 
User Setup window, where you can enter the details of your new user.  When you are 
done, click the Save button and the User Setup window will close.  At this point, the new 
user that you have just created will now be listed in the From and To User list boxes and 
it will be selected in the To User list box.  You can now select the company to copy to 
and click Next.  This will copy access to the new user and also grant the new user 
access to the “to company”.  
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Filter Maintenance window 

 

The Filter Maintenance window is used to create your own Filters for use on the Security 
Manager window.  The window is accessible from the Setup menu and also by zooming 
on the Filter ID on the Security Manager window. 

You can combine security items of all types into the same filter.  You can choose to use 
the folder structure that appears in the Available Object list on the left, or you can create 
your own folder structure to organize the objects in your Filter.  However, you may only 
change security settings at the Role-level.  Any other type of object you add to your Filter 
will be for display only. 
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The Available Objects tree 

The tree on the left side of the window shows all of the security items that are available 
for the type selected in the View drop-down.  This is where you will select the objects 
that will appear in your Filter.  We will refer to it as the Available tree.  Each type is listed 
below: 

Type Description 

Roles Lists all of the Security Roles that are defined in the system. 

Windows Lists all Windows for which security can be set, organized by Product and Series. 

Reports Lists all Reports, organized by Product and Series. 

You can choose individual objects to be a part of your Filter, or you can select an entire 
folder (e.g., Product, Series, etc.).   

Immediately above the Available tree, and to the right, are the Expand All and Collapse 

All buttons .  These are useful when navigating the tree to find objects. 

Below the Available tree is a Search box.  Type any text here and click the Search 

button and the tree will be positioned to the next occurrence of the string after the 
location where the tree is currently positioned.  If you want to search again, just hit the 
Search button again and the search will continue from that point on.  Note that you can 
also specify that the search be case-sensitive by checking the Match Case check box.  

The Selected Objects tree 

The tree on the right side of the window shows all of the security items you have already 
selected for the currently displayed Filter.  We will refer to it as the Selected tree. 

The Expand / Collapse All buttons work the same as the ones above the Available tree. 

Other controls 

Between the two trees you will notice a column of buttons.  These buttons provide 
various functions for interacting with the two trees, and they are described in detail in the 
table below: 

Button Description 

Insert Copies the item selected in the Available tree to the current location in the Selected tree.  
The Selected tree must be positioned to the root or to a folder. 

Insert All Copies ALL items in the Available tree to the current location in the Selected tree.  The 
Selected tree must be positioned to the root or to a folder. 

Delete Deletes the item at the current location in the Selected tree. 

Delete All Deletes ALL items in the Selected tree, but does not delete the Filter itself. 

New Creates a folder called ‘New Folder’ at the current location in the Selected tree.  If the 
current location is within a folder, the new folder will be the last item in that folder.  If the 
current location is at the root level, then the new folder will be created at the bottom of the 
Selected tree. 

Rename Allows you to specify a new name for the selected folder in the Selected tree. 
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To the right of the Selected tree, there is another column of buttons.  These buttons 
allow you to move items around in the Selected tree.  They are described in detail in the 
table below: 

Button Description 

Move to Top Moves the selected item to the top of the folder that contains it.  If the item is at the root 
level, then it will be moved to the top of the tree. 

Move Up Moves the selected item up one position.  If the item is already at the top of the folder 
that contains it (or at the top of the tree, if at the root level), then it will not be moved. 

Move Down Moves the selected item down one position.  If the item is already at the bottom of the 
folder that contains it (or at the bottom of the tree, if at the root level), then it will not be 
moved. 

Move to 
Bottom 

Moves the selected item to the bottom of the folder that contains it.  If the item is at the 
root level, then it will be moved to the bottom of the tree. 

Move Down 
a Level 

Moves the selected item to a lower level in the tree hierarchy.  It does this by creating a 
new folder in the location where the selected item is and then moving the selected item 
to this new folder.  Has the effect of moving the selected item to the right.   

Move Up a 
Level 

Moves the selected item to a higher level in the tree hierarchy.  Its new location will be at 
the same level as the folder that contains it, and immediately following that folder.  Has 
the effect of moving the selected item to the left.   

Finally, the Save button will commit all changes made to the Selected tree to the 
currently displayed Filter.  Note that you cannot save a filter that contains empty folders, 
so the Save process will alert you of this condition if it exists.  You will be given the 
opportunity of automatically removing the empty folders, or cancelling the Save to 
remove them manually yourself. 
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Security What If? 
 

 

To open this window, go to Microsoft Dynamics GP > Tools > Setup > Dynamics GP Toolbox > 
Security What If.   

Description 

Changes made to security settings in Dynamics GP become permanent without the 
opportunity to review the impacted permissions before you make the change.  Because 
security in Dynamics GP can be very complex, it’s unlikely that your Security 
Administrator will know the myriad of privileges contained within a single task, let alone 
all of the tasks that can be contained in a Role.  Therefore, assigning security at the Role 
level without a detailed knowledge of how the Role is set up can end up with users being 
granted access to unintended areas. This could result in security holes, possible fraud, 
and also cause major issues at your company if your users no longer have the right 
security access to do their job. 
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The Security What If? window allows you to see what specific permissions will actually 
change if you grant or revoke access to a security role in Dynamics GP.  By reviewing 
these changes before you make them, you no longer have to worry about whether you 
are assigning the correct role.  Furthermore, once you find the role that you want, you 
can even make that security change right on this window. 

To use the Security What If? window, perform the following process: 

1. From the Company drop-down, select the Company for which you want to review 
the security change. 

2. Enter or select a User for which you want to review the security change. 

3. If you are planning to remove access to the role, select Revoke for Access type; 
if you are planning to add access to the role, select Grant for Access type. 

4. Enter or select the Security Role that you are planning to add to or remove from 
the User and Company that you specified in steps 1 and 2. 

5. Click the Redisplay button. 

The window will list the new forms, reports, posting permissions, etc. that the user will 
now be able to access (or no longer be able to access) if the suggested change is made 
to security access.  These results are presented in an Explorer-type format at the bottom 
of the window. 

When reviewing these changes, you can group them by Product or by Type by clicking 
the header above the tree on the left side of the results area.  You can then select an 
individual product or resource type and you will see only the results that match that 
product or type.   

If you are OK with the individual changes listed, then you can click the Grant Access or 
Revoke Access button to actually make the security change. 
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Version Pro 

Version control over 3rd Party products on your Microsoft Dynamics GP network. 

 

This window opens automatically after you log in if there are version conflicts on your workstation. 
You can access this window manually in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> Version 
Pro Products. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Version Pro Products from the Dynamics GP Toolbox sub 
menu. 

Description 

Version Pro is designed to ease the hassles of maintaining workstations on your 
Dynamics GP network.  With several thousand after-market solutions for Dynamics GP 
available, it is inevitable that your site has several additional products installed on each 
and every workstation using Dynamics GP.  In fact, common elements like SmartList, 
HR, Fixed Assets, Collections Management, and other Dynamics GP integrated 
solutions distributed by Microsoft require their own installation and unique product 
dictionary.  This means that you, as a network administrator need to keep track of each 
and every product version for all workstations on your network. 

Version Pro is designed to keep track of each product you have installed at a system 
level, and it takes the next step in ensuring that every workstation on your network is on 
the same version for every product.  This is critical to managing your network: if one user 
is using an outdated version of one product, data corruption and downtime can result. 

Version Pro verifies upon login that all products required by the system are loaded and 
are on the current version.  Optional logging of incorrectly configured workstations is 
ideal for centralized management and control.  System administrators can force users to 
exit the system when they are not operating with the correct products or versions loaded. 
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Product Maintenance 

The Version Pro Product Maintenance window (shown above) shares a wealth of 
information about the products loaded at this workstation and products entered into the 
system registry.  This is the same window that will open at user workstations when there 
are version conflicts at login.  As an administrator, you may wish to edit system registry 
entries using this window. 

The All Products list shows products which are entered in the system registry of Version 
Pro, as well as products installed on your workstation.  The Status column indicates if a 
product is loaded correctly and on the correct version.  Any products with version 
conflicts will have an icon next to the Product Name with a description of the problem in 
the Status column. 

Below the list are the Properties button which will enable a user to edit or view properties 
for a specific product, and the Fix button which will give specific instructions to a user on 
how to fix problems with products they have loaded. 

 You must be logged in as a Version Pro System Administrator to see the 

Properties button.  Users can also see this button if you have enabled the Users 

Can Edit System Registry option on the Version Pro tab of the System Settings 

window. 

Clicking the OK button closes the Version Pro Product Maintenance window.  If there are 
still products listed that have version conflicts, you will be asked to confirm that you want 
to exit without first resolving these conflicts. 

The Exit Microsoft Dynamics GP button closes the entire Dynamics GP application.  
Depending upon the options chosen by the Administrator on the System Settings 

window, this may be the only option available to a User when there is a version conflict.. 

Viewing and Changing Product Properties 

To view and change properties of a product, select that product in the list and click the 
Properties button.  The Product Properties window will open: 
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The Delete button will remove this product from the system registry.  Deleting a product 
means that no users should have the product loaded at any workstation.  The OK button 
saves changes and closes the window.  The Cancel button closes the window as well, 
but discards any changes. 

Product ID is the ID assigned to the loaded product as determined by the product 
provider.  Microsoft issues Product IDs to Solution Providers so that each product 
solution is unique in the Dynamics GP community. 

Product Name is the name assigned to the loaded product as determined by the product 
provider.  This name also appears in the Dynamics GP launch file.  For more information 
on the launch file, consult Dynamics GP documentation. 

Registered Module Number is the module used by the product to store its version 
information.  A module is Dynamics GP’s way of subdividing a product into distinct 
areas, such as the General Ledger module, the Receivable module, and so on.  In the 
past, these modules had distinctive numbering schemes.  The module used by 
Dynamics GP for the core product is 66.  Other solution providers can choose their own 
module number when they create their product.  Version Pro cycles through all modules 
and uses the first module found to contain a Major, Minor, or Build number.  It is unlikely 
you will ever have to modify this number.  For more information about which module a 
product uses, contact the provider of that product. 

Major Version Number is the highest-order portion of the version number for a given 
product.  Each time a product provider releases an update of their product, a Major, 
Minor, and Build number is stamped on the product dictionary to track version 
information.  This is the key tracking mechanism of Version Pro.  Version Pro reads 
these version numbers from the product dictionaries loaded at the workstation.   

The Minor Version Number is the second portion of the version number.  Typically, 
product providers follow the Major and Minor versions of Dynamics GP products in their 
own products.  For instance, if Dynamics GP is on version 5.5, the Major and Minor 
version number for a compatible product is often 5 and 5 and well. 

The Build Number is the most likely variable in an installed dictionary.  The Build 
Number typically refers to the providers tracking number for releases with this Major and 
Minor version. 

Some products are optional at workstations.  Checking the Optional Product box for a 
system registry entry keeps Version Pro from checking for this product on other 
workstations. 

In the rare case that Version Pro does not default to the correct module, double-click the 
module in the Module Numbers list box, and the Major Version Number, Minor Version 
Number, and Build Number will be inserted in the appropriate fields automatically.  Click 
OK to save these changes. 
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Fixing Version Conflicts 

To fix a version conflict, select the product in the list and click the Fix button.  The Fix 
Product Error window will open: 

 

The OK button closes the window without making any changes.  The other buttons at the 
top of the window will vary based on the Error Message displayed.   

The Add button adds the product to the system registry.  You will only see the Add 
button when the Error Message is ‘Not System Registered.’ 

The Update button will do the following, based on the Error Message: 

• ‘Missing Product’ – updates the system registry to indicate that this product is 
OPTIONAL.   

• ‘Incorrect Version’ – updates the system registry with the version of the product 
that is loaded on your workstation. 

The Delete button will only be available when the Error Message is ‘Missing Product’.  
This will remove the product from the System Registry.  Deleting a product means that 
no users should have the product loaded at any workstation.   
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Version Pro Conflict Log Inquiry 

This is where all version conflicts can be viewed by the System Administrator. 

 

You can access this window in one of two ways: 

• Go to Inquiry >> Dynamics GP Toolbox >> Version Pro Conflict Log. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Inquiry area, select Version Pro Conflict Log from the Dynamics GP Toolbox sub 
menu. 

Description 

Version Pro Conflict Log Inquiry is designed for a System Administrator to track conflicts 
users are having with products.  The log records the date and time of the conflict, the 
user who had the conflict, the conflict type, and the product information for the product 
loaded at the workstation. 

The Delete Selected button deletes selected entries in the list.  You can select individual 
entries in the list by clicking on them.  You can also use the Shift and Ctrl keys along 
with the mouse to multi-select several entries. 

The Delete All button deletes all entries in the log. 
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Conditional Field Level Security 

Allows conditions to be entered on Field Security IDs. 

 

You can access this window by first going to Microsoft Dynamics GP >> Tools >> Setup >> 
System >> Field Level Security.  Then double-click a Field Security ID to open the Field Security 
Maintenance window.  Now enter Ctrl-Q or choose Extras >> Additional >> Conditional Security. 

Description 

The Conditional Field Level Security tool replaces the Conditional Scripting feature 

introduced in Advanced Security for Great Plains version 7.0, but removed for version 

8.0.   

Administrators who have knowledge of Dexterity can include additional security settings 
to Field Level Security. It also includes some examples of how and when you can use 
Field Level Security Scripting and scripts you might use when setting up a field security 
ID. 

When you first enter the Conditional Field Level Security window, if no script has been 
entered yet, the window will be disabled.  Check the box "Activate Conditional Field 
Security" and you will now be able to enter a Dexterity script.   

The script you write will be in Dexterity’s SanScript programming language.  It must 
begin with an inout boolean parameter such as is shown in the screen image above.  
You can use the Names and Tables button to look up resources.  It is a good idea to 
click the Check Syntax button to test your script for errors. 

Press OK when you are finished editing.  If you need to disable the script’s functionality 
but keep the script itself, you can uncheck the "Activate Conditional Field Security" 
checkbox.   
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Security modes that require scripting 

The four security modes that require conditional scripting are described below. 

Restore After The changes to a field that has this security ID won’t be saved after users 
or classes with access to the field exit that field. 

Hide Scrolling Line Users that have this field security ID can’t scroll down in a window. 
This security mode will conditionally reject records from a scrolling window. 

If you don’t use scripting with Hide Scrolling Line mode, all scrolling lines will be 

hidden. 

You must use the Resource Explorer to select the scrolling window as your resource. 
The SanScript code must be written to compare against values in the table buffer 
passed as a reference parameter to the script, and pass out a value specifying whether 
the current line should be hidden. 

This mode uses a reject record command and can be slow when rejecting a large amount 

of data from a large table. 

Range Scrolling Line Users that have this field security ID only can scroll down to a 
certain point in a window. You must select the field used to fill the scrolling window. The 
SanScript code must be written to apply a range to the table buffer passed as a 
reference parameter to the script. You can use the range start and range end 
commands, as well as the SQL optimized range where command. If you have made 
changes to the range you must use a fill window command to refresh the contents of 
the scrolling window. You must ensure that your range and fill window commands are 
using the correct table index. 

Restore After with Table Users that have this field security ID can make changes in a 
field but the changes won’t be saved. Changes are saved based on business logic in the 
script. This mode is similar to the Restore After mode, except that this mode allows  
Conditional scripting code to directly access a table buffer from the form. 

Security modes 

This table shows the various types of security modes available with Field Level Security 
and explains where conditional scripting will be run. Security Modes 13-15 also have a 
form’s table buffer passed to the conditional script as a reference. 

Security Mode Mode Type Dexterity Trigger Type 

1=No Action N/A N/A 

2=Password Before Field Mode Before Field_PRE 

3=Password After Field Mode Before Field_CHG 

4=Warning Before Field Mode Before Field_PRE 

5=Lock Field Field Mode After Window_PRE 

6=Disable Field Field Mode After Window_PRE 

7=Hide Field Field Mode After Window_PRE 

8=Password Window Window Mode Before Window_PRE 

9=Disable Window Window Mode Before Window_PRE 

10=Password Form Form Mode Before Form_PRE 

11=Disable Form Form Mode Before Form_PRE 

12=Restore After Field Mode (Scripting) Before Field_CHG 

13=Hide Scrolling Line Scrolling Window Mode 
(Scripting) 

Before Window_FILL 

14=Range Scrolling Line Field Mode (Scripting) After Field_CHG 

15= Restore After with Table Field Mode (Scripting) Before Field_CHG 
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Applying conditional scripting 

Use the Field Security Maintenance window to apply conditional scripting to security 
settings. 

1. Open the Field Level Security window (Setup >> System >> Field Level Security) 

2. Click Add to open the Field Security Maintenance window. 

3. Create a field security ID, or modify an existing one using the Field Security 
Maintenance window.  

4. Activate conditional field security by marking the Activate Conditional Field 
Security check box in the Field Security Maintenance window. 

5. Enter your script into the conditional scripting field located at the bottom of the 
Field Security Maintenance window. 

• Select Names to look up and insert the names of forms, fields, or windows in 
the script. 

• Select Tables to look up and insert the names of a table or field into the script. 

6. Select Check Syntax to check the syntax of the entered script. 

7. Choose Save. 

You can’t save your changes if you have syntax errors in your script. 

 

 

Case 1: Limiting site access to users 

Situation You are a global company and you have multiple warehouses in various 
countries or regions. You want sales clerks in each country/region to only be allowed to 
sell from warehouses located in their country/region. 

Solution Use Field Level Security Scripting to only allow users to access sites within 
their own company. Enter a user class ID into the Country field in the Site Maintenance 
window and then assign users to the same user class to create a many to many 
relationship between users and sites. 

See the following scripting example. Both field security IDs are needed for this case. 

Example: 

Form Name  IV_Location_Lookup 

Window Name IV_Location_Lookup 

Field Name  Redisplay Button 

Table Name  IV_Location_SETP 

Security Mode Range Scrolling Line 

These scripting samples contain line breaks. You must delete the line breaks before these 

scripts will work in Field Level Security Scripting. 
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Script: 

inout reference INOUT_Table_Reference; {Refer to table with the following syntax: 

  table(INOUT_Table_Reference)} 

out boolean OUT_Active; 

 

{default form to ‘IV_Location_Lookup’;} 

{default window to ‘IV_Location_Lookup’;} 

OUT_Active=false; 

 

if isopen(form SOP_Entry) then 

   range table (INOUT_Table_Reference) where ““; 

   ‘User ID’ of table SY Users_MSTR = ‘User ID’ of globals; 

   get table SY_Users_MSTR; 

   if err() = OKAY then 

      if not empty(‘User Class’ of table SY_Users_MSTR) then 

         focus ‘Redisplay Button’ of window ‘IV_Location_Lookup’ of form  

            ‘IV_Location_Lookup’; 

         clear window ‘Location_Lookup_Scroll’ of form ‘IV_Location_Lookup’; 

         range table (INOUT_Table_Reference) where 

            physicalname(‘Country’ of table IV_Location_SETP) + “ =’”+ 

            ‘User Class’ of table SY_Users_MSTR + ”’”; 

         fill window ‘Location_Lookup_Scroll’ of form ‘IV_Location_Lookup’; 

         focus ‘Location Code’ of window ‘Location_Lookup_Scroll’  

            of form ‘IV_Location_Lookup’; 

         OUT_Active = true; 

      end if; 

   end if; 

end if; 

Form Name  SOP_Entry 

Window Name SOP_Entry 

Field Name  Location Code 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'SOP_Entry';} 

{default window to 'SOP_Entry';} 

OUT_Active = false; 

 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      if not empty('Location Code' of window 'SOP_Entry' of form 'SOP_Entry') then 

         'Location Code' of table IV_Location_SETP = 'Location Code'  

            of window 'SOP_Entry' of form 'SOP_Entry'; 

         get table IV_Location_SETP; 

         if err() = OKAY then 

            if 'Country' of table IV_Location_SETP <> 'User Class' of table SY_Users_MSTR  

            then 

               beep WARNSOUND; 

               warning "This site is not available;"; 

               OUT_Active = true; 

            end if; 

         end if; 

      end if; 

   end if; 

end if; 
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Case 2: Restricting access to customers 

Situation You want to restrict a user’s access to your customers. 

Solution You can restrict access to customer records based on a user’s class and the 
user-defined field of the Customer Maintenance window or lookup windows by creating 
field security IDs for each window and adding conditional scripting. 

See the following scripting examples. All five scripts are needed to restrict access. 

Example 1: Limiting customer maintenance 

Form Name  RM_Customer_Maintenance 

Window Name RM_Customer_Maintenance 

Field Name  Display Existing Record 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'RM_Customer_Maintenance';} 

{default window to 'RM_Customer_Maintenance';} 

OUT_Active = false; 

 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      { Get Record from table, if it exists } 

      'Customer Number' of table RM_Customer_MSTR = 'Customer Number' of window  

         RM_Customer_Maintenance of form RM_Customer_Maintenance; 

      get table RM_Customer_MSTR; 

      if err() = OKAY then 

         { Validate User Defined Field } 

         if 'User Defined 2' of table RM_Customer_MSTR <> 'User Class' of table  

         SY_Users_MSTR then 

            run script 'Clear Button' of window 'RM_Customer_Maintenance' of form 

               'RM_Customer_Maintenance'; 

            clear '(L) Temp Control Number' of window 'RM_Customer_Maintenance' of form 

               'RM_Customer_Maintenance'; 

            focus 'Customer Number’ of window RM_Customer_Maintenance of form 

               RM_Customer_Maintenance; 

            warning "Access to Customer ID " +  

               'Customer Number' of table RM_Customer_MSTR + 

               " is only available to Users of Class: " +  

               ‘User Defined 2' of table RM_Customer_MSTR; 

            OUT_Active = true; 

         end if; 

      end if; 

   end if; 

end if; 
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Example 2: Limiting customer lookup 

Form Name  Customer_Lookup 

Window Name Customer_Lookup 

Field Name  Customer Sort By 

Table Name  RM_Customer_MSTR 

Security Mode Range Scrolling Line 

Script: 

inout reference INOUT_Table_Reference; 

 

{Refer to table with the following syntax: table(INOUT_Table_Reference)} 

out boolean OUT_Active; 

{default form to 'Customer_Lookup';} 

{default window to 'Customer_Lookup';} 

OUT_Active = false; 

 

{ For Customers Only } 

if '(L) View GB' of window 'Customer_Lookup' of form 'Customer_Lookup' <> CUSTOMERS then 

   abort script; 

end if; 

range table(INOUT_Table_Reference) where ""; 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      { Validate User Defined Field } 

      focus 'Redisplay Button' of window 'Customer_Lookup' of form 'Customer_Lookup'; 

      clear window 'Customer_Lookup_Scroll' of form 'Customer_Lookup'; 

      range table(INOUT_Table_Reference) where  

         physicalname('User Defined 2' of table RM_Customer_MSTR) +  

         " = '" + 'User Class' of table SY_Users_MSTR + "'"; 

      fill window 'Customer_Lookup_Scroll' of form 'Customer_Lookup'; 

      focus 'Customer Number' of window 'Customer_Lookup' of form 'Customer_Lookup'; 

      OUT_Active = true; 

   end if; 

end if; 
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Example 3: Limiting customer address maintenance 

Form Name  RM_Customer_Address 

Window Name RM_Customer_Address 

Field Name  Display Existing Record 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'RM_Customer_Address';} 

{default window to 'RM_Customer_Address';} 

OUT_Active = false; 

 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      { Get Record from table, if it exists } 

      'Customer Number' of table RM_Customer_MSTR = 'Customer Number' of window  

         RM_Customer_Address of form RM_Customer_Address; 

      get table RM_Customer_MSTR; 

      if err() = OKAY then 

         { Validate User Defined Field } 

         if 'User Defined 2' of table RM_Customer_MSTR <> 'User Class' of table  

            SY_Users_MSTR then 

            run script delayed 'Clear Button' of window 'RM_Customer_Address' of form  

               'RM_Customer_Address'; 

            clear '(L) Temp Control Number' of window 'RM_Customer_Address' of form  

               'RM_Customer_Address'; 

            focus 'Customer Number' of window RM_Customer_Address of form  

               RM_Customer_Address; 

            warning "Access to Customer ID " + 

               'Customer Number' of table RM_Customer_MSTR +  

               " is only available to Users of Class: " +  

               'User Defined 2' of table RM_Customer_MSTR; 

            OUT_Active = true; 

         end if; 

      end if; 

   end if; 

end if; 
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Example 4: Limiting customer address lookup 

Form Name  Address_Lookup 

Window Name Address_Lookup 

Field Name  Sort By 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'Address_Lookup';} 

{default window to 'Address_Lookup';} 

OUT_Active = false; 

 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      { Get Record from table, if it exists } 

      'Customer Number' of table RM_Customer_MSTR = 'Customer Number' of window  

         Address_Lookup of form Address_Lookup; 

      get table RM_Customer_MSTR; 

      if err() = OKAY then 

         { Validate User Defined Field } 

         if 'User Defined 2' of table RM_Customer_MSTR <> 'User Class' of table 

         SY_Users_MSTR then 

            clear window 'Address_Lookup_Scroll' of form 'Address_Lookup'; 

            clear 'Customer Number' of window Address_Lookup of form Address_Lookup; 

         end if; 

      end if; 

   end if; 

end if; 
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Example 5: Limiting customer ID for RM_Sales_Entry 

Form Name  RM_Sales_Entry 

Window Name RM_Sales_Entry 

Field Name  Customer Number 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'RM_Sales_Entry';} 

{default window to 'RM_Sales_Entry';} 

OUT_Active = false; 

 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      { Get Record from table, if it exists } 

      'Customer Number' of table RM_Customer_MSTR = 'Customer Number' of window  

         RM_Sales_Entry of form RM_Sales_Entry; 

      get table RM_Customer_MSTR; 

      if err() = OKAY then 

         { Validate User Defined Field } 

         if 'User Defined 2' of table RM_Customer_MSTR <> 'User Class' of table  

         SY_Users_MSTR then 

            warning "Access to Customer ID "+ 

               'Customer Number' of table RM_Customer_MSTR + 

               " is only available to Users of Class: " + 

               'User Defined 2' of table RM_Customer_MSTR; 

            OUT_Active = true; 

         end if; 

      end if; 

   end if; 

end if; 
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Case 3: Setting default values in Customer Maintenance field automatically 

Situation You want default values in a Great Plains window to be set automatically. 

Solution Create a field security ID for each window using the Lock, Disable, or Hide 
Field modes in any field in the window and add conditional scripting to apply any default 
values to be the standard for those fields. See the following scripting example. 

Example: 

Form Name  RM_Customer_Maintenance 

Window Name RM_Customer_Maintenance 

Field Name  User Defined 2 

Security Mode Lock Field 

Script: 

out boolean OUT_Active; 

 

{default form to 'RM_Customer_Maintenance';} 

{default window to 'RM_Customer_Maintenance';} 

OUT_Active = false; 

 

{ Get Current User's Class } 

'User ID' of table SY_Users_MSTR = 'User ID' of globals; 

get table SY_Users_MSTR; 

if err() = OKAY then 

   if not empty('User Class' of table SY_Users_MSTR) then 

      'User Defined 2' of window 'RM_Customer_Maintenance' of form 

         'RM_Customer_Maintenance' = 'User Class' of table SY_Users_MSTR; 

      run script 'User Defined 2' of window 'RM_Customer_Maintenance' of form  

         'RM_Customer_Maintenance'; 

      { Field on Main window, let Field Security lock it } 

      OUT_Active = true; 

   end if; 

end if; 
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Case 4: Automatically generating next master number 

Situation You want to automatically generate the next master number in a Great Plains 
maintenance window, instead of having to rely on the user to know the proper format 
you use to create new IDs for customers, vendors, employees, or other types of master 
records. 

Solution You can generate next master numbers automatically by making a variation of 
the setting of default values. Some master records will require more than one script. 

This field security ID is for generating a next vendor number based on the first few 
characters of the vendor name and a numeric value. See the following scripting 
example. 

Example: 

Form Name  PM_Vendor_Maintenance 

Window Name PM_Vendor_Maintenance 

Field Name  Save Button 

Security Mode Lock Field 

Script: 

out boolean OUT_Active; 

 

{ Used for AutoGen Number } 

local integer l_length; 

local long l_number; 

 

{default form to 'PM_Vendor_Maintenance';} 

{default window to 'PM_Vendor_Maintenance';} 

OUT_Active = false; 

 

l_length = 8; { Length of Numeric part of Number } 

l_number = 1;{ First Number in AutoGen Sequence } 

 

{ Calculate Next Number } 

range clear table PM_Vendor_MSTR; 

clear table PM_Vendor_MSTR; 

'Vendor ID' of table PM_Vendor_MSTR = pad(str(0), LEADING, str(0), l_length); 

range start table PM_Vendor_MSTR; 

fill table PM_Vendor_MSTR; 

'Vendor ID' of table PM_Vendor_MSTR = pad(str(10^l_length-1), LEADING, str(0), l_length); 

range end table PM_Vendor_MSTR; 

get last table PM_Vendor_MSTR; 

if err() = OKAY then 

   l_number = value('Vendor ID' of table PM_Vendor_MSTR) + 1; 

end if: 

range clear table PM_Vendor_MSTR; 

 

{ Insert Next Number } 

'Vendor ID' of window 'PM_Vendor_Maintenance' of form 'PM_Vendor_Maintenance' = 

   pad(str(l_number), LEADING, str(0), l_length); 

focus 'Vendor ID' of window 'PM_Vendor_Maintenance' of form 'PM_Vendor_Maintenance'; 

force change 'Vendor ID' of window 'PM_Vendor_Maintenance' of form 

   'PM_Vendor_Maintenance'; 
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Case 5: Changing the behavior of transaction windows 

Situation You want to change how a Great Plains maintenance window works when you 
type the ID of a customer, vendor, or employee that does not currently exist. 

Solution This is possible by using Field Level Security to create field security IDs for 
each window and adding conditional scripting to change the value of the message 
presented or automatically respond to the message. This allows you to establish your 
own business rules and avoid having the user select the wrong action. For example, you 
might decide that the record should always be created, or the record should not be 
created. A message can be displayed to indicate that a specific person in your company 
must create the new master record. 

This example gives users the option of opening the lookup window when the customer 
ID that was entered does not exist. See the following scripting example. 

Example: 

Form Name  RM_Sales_Entry 

Window Name RM_Sales_Entry 

Field Name  Customer Number 

Security Mode Restore After 

Script: 

out boolean OUT_Active; 

 

{default form to 'RM_Sales_Entry';} 

{default window to 'RM_Sales_Entry';} 

OUT_Active = false; 

 

{ Check if Record exists in table } 

'Customer Number' of table RM_Customer_MSTR = 'Customer Number' of window RM_Sales_Entry  

   of form RM_Sales_Entry; 

get table RM_Customer_MSTR; 

if err() <> OKAY then 

   beep INFOSOUND; 

   if ask("Customer does not exist, open Lookup instead?", getmsg(YES), getmsg(NO), "") =  

   ASKBUTTON1 then 

      run script 'Lookup Buttons'[3] of window 'RM_Sales_Entry' of form 'RM_Sales_Entry'; 

   end if; 

   OUT_Active = true; 

end if; 
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Case 6: Changing default settings of other windows 

Situation You want to change the default settings of dialog boxes, other than in 
maintenance windows. 

Solution In most instances you can change default behavior for other modal messages 
presented to the user. See the following scripting example. 

Example: 

Form Name  RM_Transaction_Inquiry 

Window Name RM_Transaction_Inquiry 

Field Name  Zoom Button 

Table Name  RM_Inquiry_TEMP 

Security Mode Restore After with Table 

Script: 

inout reference INOUT_Table_Reference;{Refer to table with the following syntax:  

       table(INOUT_Table_Reference)} 

out boolean OUT_Active; 

 

local string l_sTrxSource; 

 

default form to 'RM_Transaction_Inquiry'; 

default window to 'RM_Transaction_Inquiry_Scroll'; 

OUT_Active = false; 

 

l_sTrxSource = 'TRX Source' of table(INOUT_Table_Reference); 

if   substring(l_sTrxSource,1,length(getmsg(8037))) = getmsg(8037) 

  or substring(l_sTrxSource,1,length(getmsg(SOP_PREFIX))) = getmsg(SOP_PREFIX) then 

   if ask("Would you like to display Receivables Transaction Zoom or originating source  

   Transaction zoom", "&Receivables","&Originating","") = ASKBUTTON1 then 

      OUT_Active = true; 

      call RM_Zoom_To_Entry_Form, 

         'Document Number', 

         'RM Document Type-All', 

         'Document Status', 

         ""{'TRX Source' of table RM_Inquiry_TEMP}, 

         'Transaction Description', 

         'Currency View' of window RM_Transaction_Inquiry, 

         WINID_RMTRXINQUIRY; 

   end if; 

end if; 
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Schedule Setup window 
 

 

Description 

Schedules are used by some of the tools in Dynamics GP Toolbox, such as the Inactivity 
Timeout tool and the System Lockout tool, to define when those tools are in effect.  The 
Schedule Setup window is where you specify the time periods during each week that 
you would like the Schedule to be active.  These time periods, which are listed in this 
window, are called Schedule Items.  

Each Schedule Item can be enabled or disabled by clicking the icon at the left of each 
item in the list (notice in the screen shot above that the Schedule Items for Tuesday and 
Friday are enabled, but the one Thursday is disabled). This can be useful if you have 
time periods that you only occasionally want to be part of a schedule.  This allows you to 
set those periods up once and then add or remove them with one mouse click. 

Another feature of this window is the graphical representation of the entire week’s active 
periods.  By default, each enabled Schedule Item for this Schedule will appear as green 
blocks, which the periods that do not have active Schedule Items appear in white.  As 
you add, change, delete, enable, or disable Schedule Items, you can see it reflected 
immediately in this display.   

You can also customize the colors that you want to use for the active and inactive blocks 
in the graph.  You do this by clicking the colored boxes at the bottom of the window 
labeled, “Not Active” and “Active”.  As you click them, the graph changes to reflect the 
colors that you have chosen. 
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Adding, Editing, and Deleting Schedule Items 

Click the Add Schedule Item button ( ) to add a new Schedule Item.  This will open the 
Schedule Item Entry window: 

 

Here you will specify the day of the week and time that you want this Schedule Item to 
start and also the day of the week and time that you want it to end.  You may choose to 
activate this Schedule Item by clicking the Active check box (the default), or you can 
uncheck this box if you want to add the Schedule Item now but intend to actually put it 
into effect at a later time.  Checking or unchecking this box has the same effect as 
clicking the enable/disable icon on the Schedule Setup window. 

When you are done, click the Save button and you will see the new Schedule Item in the 
Schedule Setup window. 

You can also use the Edit Schedule Item button ( ) to change these settings, and the 

Delete Schedule Item button ( ) to delete a previously entered Schedule Item. 
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User Group Setup window 
 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> User 
Group Setup. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select User Group Setup from the Dynamics GP Toolbox sub menu. 

Description 

User Groups are a way to define collections of Users or User Classes.  They are used to 
assign permissions or restrictions to certain functionality of some of the tools in 
Dynamics GP toolbox. 

To add Users to a User Group, first enter or select the User Group ID to which you want 
to add Users.  Then select Users in the Show drop-down at the top of the left-hand list 
box to list all users in the system.  Now just select the Users that you want to add by 
marking their check boxes, then clicking the Insert button.  You will now see these Users 
move to the right-hand list box.  You would use a similar procedure to add User Classes 
to the User Group by first selecting User Classes in the Show drop-down.   

Note that you can select any number of Users and/or User Classes to add to a User 
Group. 

On the Dynamics GP Web Client, you can double-click a User or Class to mark it. 
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Task Builder Wizard  
 

 

You can access this window in one of two ways: 

• Go to Microsoft Dynamics GP >> Tools >> Setup >> Dynamics GP Toolbox >> Task 
Builder. 

• Click the Administration navigation button to open the Administration Area Page.  Then, 
from the Setup area, select Task Builder from the Dynamics GP Toolbox sub menu. 

Description 

The Task Builder Wizard gives you a more intuitive way to add windows to a Security 
Task ID in Microsoft Dynamics GP.  Instead of having to know the Product and Series 
that a window belongs to, all you need to do is to open the window however you 
normally open it, and the wizard allows you to add that window to the Security Task. 

When you first start the Task Builder Wizard, you are presented with a Task Builder 
Welcome window.  Click the Next button and the Task Builder Wizard window above will 
open.  The first thing you want to do is to enter or select a Security Task ID from the 
lookup.  Or, if you want to add a new Security Task, then enter the Security Task ID, 
Category, Task Name, and Task Description.  Then click the Next button.   

You will now be put into “Task Builder mode.”  The first thing you will notice is that the 
Task Builder window opens.  The Task Builder window has instructions for how to 
proceed, but we will briefly describe your options here as well.  You actually have two 
different options for adding windows to the Security ID that you selected above.   
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Option 1: The typical method is to just open one of the windows that you want to add.  
You will see that the Task Builder window opens to the right of that window and that the 
Product and Window are filled in for you.  At this point, all you need to do is to click the 
Add button and that window will be added to the Windows to be added to Task list.  
You can now open the next window that you want to add and click the Add button again.   
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Option 2: You can also add windows by clicking the Add window using Mentor search 
button ( ), which opens the Add Using Mentor window: 

 

Enter the name of the window that you want to add to the Security Task ID.  You can 
also enter only part of the name, for instance “purch ord proc doc inq”.  Then click the 

Mentor Search button ( ).  Mentor will then list all of the windows that it thinks you were 
trying to find.  Search through the results list to find the one you want, then select it and 
click the Add button.  If you don’t find it, try entering a little more of the name and click 
the Mentor Search button again. 

After selecting the desired window, you should see it listed in the Task Builder window. 

When you have all of the windows that you want to add listed in the Task Builder 
window, click the Done button.  This will take you back to the Task Builder Wizard 
window where it will show you a summary of the changes you are about to make to the 
Security Task ID: 

 

Click the Next button and your changes will be applied to the Security Task ID.  You will 
then be given the option to review this Security Task on the Security Task Setup 
window.  Click the Finish button and the Task Builder Wizard will close.   


